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Taking a Microsoft Office 
Specialist Exam

Desktop computing proficiency is increasingly important in today’s business world. As 
a result, when screening, hiring, and training employees, employers can feel reassured 
by relying on the objectivity and consistency of technology certification to ensure the 
competence of their workforce. As an employee or job seeker, you can use technology 
certification to prove that you already have the skills you need to succeed, saving current 
and future employers the trouble and expense of training you.

Microsoft Office Specialist Certification
Microsoft Office Specialist certification for Microsoft Office 2010 is designed to assist 
employees in validating their skills with programs in the Office 2010 software suite. 
The following certification paths are available:

●	 A Microsoft Office Specialist (MOS) is an individual who has demonstrated proficiency 
by passing a certification exam in one or more of the Office 2010 programs, including 
Microsoft Word, Excel, PowerPoint, Outlook, and Access, or in Microsoft SharePoint.

●	 A Microsoft Office Specialist Expert (MOS Expert) is an individual who has taken his 
or her knowledge of Office 2010 to the next level and has demonstrated by passing  
a certification exam that he or she has mastered the more advanced features of 
Word 2010 or Excel 2010.

Selecting a Certification Path
When deciding which certifications you would like to pursue, you should assess the following:

●	 The program and program version(s) with which you are familiar
●	 The length of time you have used the program and how frequently you use it
●	 Whether you have had formal or informal training in the use of that program
●	 Whether you use most or all of the available program features
●	 Whether you are considered a go-to resource by business associates, friends, and 

family members who have difficulty with the program
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Candidates for MOS-level certification are expected to successfully complete a wide range 
of standard business tasks, such as formatting a document or worksheet and its content; 
creating and formatting visual content; or working with SharePoint lists, libraries, Web Parts, 
and dashboards. Successful candidates generally have six or more months of experience 
with the specific Office program, including either formal, instructor-led training or self-study 
using MOS-approved books, guides, or interactive computer-based materials.

Candidates for MOS Expert-level certification are expected to successfully complete more 
complex tasks that involve using the advanced functionality of the program. Successful 
candidates generally have at least six months, and may have several years, of experience 
with the programs, including formal, instructor-led training or self-study using MOS-
approved materials.

Test-Taking Tips
Every MOS certification exam is developed from a set of exam skill standards (referred to 
as the objective domain) that are derived from studies of how the Office 2010 programs 
or SharePoint are used in the workplace. Because these skill standards dictate the scope of 
each exam, they provide critical information about how to prepare for certification. This 
book follows the structure of the published exam objectives; see “Using This Book to 
Study for a Certification Exam” at the beginning of this book for more information.

The MOS certification exams for the Office 2010 programs and SharePoint are performance 
based and require you to complete business-related tasks in the program for which you 
are seeking certification. You might be told to adjust program settings or be presented 
with a file and told to do something specific with it. Your score on the exam reflects how 
well you perform the requested tasks within the allotted time.

Here is some helpful information about taking the exam:

●	 Keep track of the time. You have 50 minutes to complete the exam. Your exam time 
does not officially begin until after you finish reading the instructions provided at the 
beginning of the exam. During the exam, the amount of time remaining is shown at 
the bottom of the exam interface. You can’t pause the exam after you start it.

●	 Pace yourself. At the beginning of the exam, you will be told how many questions 
are included in the exam. Some questions will require that you complete more than 
one task. During the exam, the number of completed and remaining questions is 
shown at the bottom of the exam interface.

●	 Read the exam instructions carefully before beginning. Follow all the instructions 
provided in each question completely and accurately.

●	 Enter requested information as it appears in the instructions, but without duplicating 
the formatting unless you are specifically instructed to do so. For example, the text 
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and values you are asked to enter might appear in the instructions in bold and under-
lined text, but you should enter the information without applying these formats.

●	 Close all dialog boxes before proceeding to the next exam question unless you are 
specifically instructed not to do so.

●	 Don’t close task panes before proceeding to the next exam question unless you are 
specifically instructed to do so.

●	 If you are asked to print a document, worksheet, chart, report, or slide, perform the 
task, but be aware that nothing will actually be printed.

●	 Don’t worry about extra keystrokes or mouse clicks. Your work is scored based on its 
result, not on the method you use to achieve that result (unless a specific method is 
indicated in the instructions).

●	 If a computer problem occurs during the exam (for example, if the exam does not 
respond or the mouse no longer functions) or if a power outage occurs, contact a 
testing center administrator immediately. The administrator will restart the com-
puter and return the exam to the point where the interruption occurred, with your 
score intact.

Certification Benefits
At the conclusion of the exam, you will receive a score report, indicating whether you 
passed the exam. You can print with the assistance of the testing center administrator. If 
your score meets or exceeds the passing standard (the minimum required score), you will 
be contacted by email by the Microsoft Certification Program team. The email message 
you receive will include your Microsoft Certification ID and links to online resources, 
including the Microsoft Certified Professional site. On this site, you can download or 
order a printed certificate, create a virtual business card, order an ID card, view and 
share your certification transcript, access the Logo Builder, and access other useful and 
interesting resources, including special offers from Microsoft and affiliated companies.

Using the Logo Builder, you can create a personalized certification logo that includes 
the MOS logo and the specific programs in which you have achieved certification. If 
you achieve MOS certification in multiple programs, you can include up to six of them 
in one logo.

Taking a Microsoft Office Specialist Exam
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You can include your personalized logo on business cards and other personal promotional 
materials. This logo attests to the fact that you are proficient in the applications or 
cross-application skills necessary to achieve the certification.

For More Information
To learn more about the Microsoft Office Specialist exams and related courseware, visit:

www.microsoft.com/learning/en/us/certification/mos.aspx

Using This Book to Study  
for a Certification Exam

The Microsoft Office Specialist (MOS) exams for individual Microsoft Office 2010 programs 
are practical rather than theoretical. You must demonstrate that you can complete certain 
tasks rather than simply answering questions about program features. The successful 
MOS certification candidate will have at least six months of experience using all aspects 
of the application on a regular basis; for example, using Microsoft Outlook at work to 
send messages, track contact information, schedule appointments and meetings, track 
and assign tasks, and take notes.

This book has been designed to guide you in studying the types of tasks you are likely 
to be required to demonstrate in the MOS Expert exams for Microsoft Word 2010 and 
Microsoft Excel 2010 and the MOS Specialist exams for Microsoft Access 2010 and 
Microsoft SharePoint.

Each part of the book covers one exam. The coverage for each exam is divided into chapters 
representing broad skill sets, and each chapter is divided into sections addressing groups 
of related skills. Each section includes review information, generic procedures, and practice 
tasks you can complete on your own while studying. When necessary, we provide prac-
tice files you can use to work through the practice tasks. You can practice the procedures 
in this book by using the practice files supplied or by using your own files. (If you use 
your own files, keep in mind that functionality in some Office 2010 programs is limited  
in files created in or saved for earlier versions of the program. When working in such a 
file, Compatibility Mode appears in the program window title bar.)

Taking a Microsoft Office Specialist Exam
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As a certification candidate, you probably have a lot of experience with the program 
you want to become certified in. Many of the procedures we discuss in this book will be 
familiar to you; others might not be. Read through each study section and ensure that 
you are familiar with not only the procedures included in the section, but also the con-
cepts and tools discussed in the review information. In some cases, graphics depict the 
tools you will use to perform procedures related to the skill set. Study the graphics and 
ensure that you are familiar with all the options available for each tool.

Features and Conventions of This Book
If you have worked with previous versions of Word, Excel, Access, or SharePoint, or if you 
need help remembering how to perform a particular task, the following features of this 
book will help you locate specific information:

●	 Detailed table of contents  Scan a listing of the topics covered in each chapter 
and locate specific topics.

●	 Chapter thumb tabs  Easily locate the beginning of the chapter you want.

●	 Detailed index  Look up specific tasks and general concepts in the index, which 
has been carefully crafted with the reader in mind.

You can save time when you use this book by understanding how special instructions, 
keys to press, buttons to click, and other conventions are indicated in this book.

Convention Meaning

1
2

Numbered steps guide you through step-by-step procedures.

➜ An arrow indicates a procedure that has only one step.
See Also These paragraphs direct you to more information about a given topic in 

this book or elsewhere.
Tip These paragraphs provide a helpful hint or shortcut that makes working 

through a task easier, or information about other available options.
Interface  
elements

In procedures, the names of program elements (such as buttons and 
commands) are shown in bold characters.

Key  
combinations

A plus sign (+) between two key names means that you must hold 
down the first key while you press the second key. For example, “press 
Ctrl+Home” means “hold down the Ctrl key and press the Home key.”

User input In procedures, anything you should enter appears in bold characters.

Using This Book to Study for a Certification Exam
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Using the Book’s Companion 
Content

Before you can complete the exercises in this book, you need to copy the book’s practice 
files to your computer. These practice files, and other information, can be downloaded 
from here:  

http://www.microsoftpressstore.com/title/9780735657885

Display the detail page in your web browser and follow the instructions for downloading 
the files.

Important  The Microsoft Word 2010, Excel 2010, Access 2010, and SharePoint 2010 
programs are not available from this website. You should purchase and install those pro-
grams before using this book.

Practice files are organized by chapter (and by section number when necessary) in 
folders for Microsoft Word 2010, Microsoft Excel 2010, and Microsoft Access 2010. The 
names of the files you need to work with are provided in the practice tasks. 

No practice files are provided for the section about Microsoft SharePoint 2010, although 
practice tasks you can perform on your own site are described in each chapter. To work 
through the SharePoint section, you need full access to a SharePoint 2010 team site, 
and because SharePoint 2010 is a server-based platform rather than a desktop applica-
tion, you need access to a server or an online environment where SharePoint 2010 is 
installed or hosted. You can find information about SharePoint hosting services and the 
SharePoint trial edition at the start of that section of the book. The companion con-
tent also includes an appendix that provides an overview of SharePoint and its basic 
functionality.

Using the Book’s Companion Content
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Your Companion eBook
The eBook edition of this book allows you to:

●	 Search the full text

●	 Print

●	 Copy and paste

To download your eBook, please see the instruction page at the back of this book.

Modifying the Display of the Ribbon
The goal of the Microsoft Office working environment is to make working with Office 
documents as intuitive as possible. You work with an Office file and its contents by 
giving commands to the program in which the document is open. All Office 2010 
programs organize commands on a horizontal bar called the ribbon, which appears 
across the top of an application’s program window.

Ribbon tabs Ribbon groups

Commands are organized on task-specific tabs of the ribbon, and in feature-specific 
groups on each tab. Commands generally take the form of buttons and lists. Some  
appear in galleries. Some groups have related dialog boxes or task panes that contain 
additional commands. 

Your Companion eBook
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Tip  Some older commands no longer appear on the ribbon but are still available in 
the program. You can make these commands available by adding them to the Quick 
Access Toolbar.

The appearance of commands on the ribbon changes as the width of the ribbon 
changes. A command might be displayed on the ribbon in the form of a large button, a 
small button, a small labeled button, or a list entry. As the width of the ribbon decreases, 
the size, shape, and presence of buttons on the ribbon adapt to the available space. 
For example, if you decrease the width of the ribbon, small button labels disappear and 
entire groups of buttons are hidden under one button that represents the group. Click 
the group button to display a list of the commands available in that group. When the 
window becomes too narrow to display all the groups, a scroll arrow appears at its right 
end. Click the scroll arrow to display hidden groups.

You can customize the ribbon or the Quick Access Toolbar to suit your working style and 
to make commands you use frequently easily available. To add a command to the Quick 
Access Toolbar, right-click the command on the ribbon and then choose Add to  
Quick Access Toolbar.

Tip  The screen images shown in the procedures in this book were captured at a screen 
resolution of 1024 × 768, at 100 percent magnification, and with the default text size  
(96 dpi). If any of your settings are different, the ribbon on your screen might not look the 
same as the one shown in the book. If differences between your display settings and ours 
cause a button on your screen to look different from the one mentioned in this book, you 
can adapt the procedures to locate the command. First, click the specified tab. Then locate 
the specified group. If a group has been collapsed into a group list or group button, click 
the list or button to display the group’s commands. Finally, look for a button that features 
the same icon in a larger or smaller size than that shown in the book. If necessary, point to 
buttons in the group to display their names in ScreenTips.

To add your own tabs and groups to the ribbon, right-click the ribbon and choose 
Customize the Ribbon. In the program’s Options dialog box (the one shown here is for 
Word), click New Tab to add a tab to the ribbon. The new tab will include a new group as 
well. Use the New Group button to add another group to the custom tab or to any of the 
built-in tabs shown in the Main Tabs list. You can add commands only to custom groups, 
not to any of the built-in groups.

Modifying the Display of the Ribbon
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The Choose Commands From list provides options for displaying  popular commands, 
commands not included on the ribbon, as well as all commands or commands on specific 
tabs. Select the command you want to add to a custom group, and then click Add. Click 
Remove if you want to remove a command from a custom group.

The Rename button opens a dialog box in which you can type a name for a custom tab 
or a custom group. For a custom group, you can also select a symbol to associate with 
the group. 

If you want to return the ribbon and the Quick Access Toolbar to the default state, you 
can click Reset, Reset All Customizations.

Modifying the Display of the Ribbon
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How to Get Support and Provide 
Feedback

The following sections provide information on errata, book support, feedback, and 
contact information.

Errata & Book Support
We’ve made every effort to ensure the accuracy of this book and its companion content. 
Any errors that have been reported since this book was published are listed on our 
Microsoft Press site: 

http://www.microsoftpressstore.com/title/ 9780735657885

If you find an error that is not already listed, you can report it to us through the same 
page.

If you need additional support, please send an email message to Microsoft Press Book 
Support at mspinput@microsoft.com.

Please note that product support for Microsoft software is not offered through the 
addresses above.

We Want to Hear from You
At Microsoft Press, your satisfaction is our top priority, and your feedback our most 
valuable asset. Please tell us what you think of this book at:

www.microsoft.com/learning/booksurvey/

The survey is short, and we read every one of your comments and ideas. Thanks in 
advance for your input!

Stay in Touch
Let’s keep the conversation going! We’re on Twitter: http://twitter.com/MicrosoftPress.

How to Get Support and Provide Feedback
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	 3	 Tracking and 
Referencing Documents
The skills tested in this section of the Microsoft Office Expert exam for Microsoft Word 
2010 relate to tracking revisions in documents, merging documents, and creating 
references such as bibliographies, source citations, and indexes. Specifically, the following 
objectives are associated with this set of skills:

3.1	 Review, compare, and combine documents
3.2	 Create a reference page
3.3	 Create a table of authorities in a document
3.4	 Mark and compile an index for a document

In this chapter, you’ll learn the mechanics for creating different types of reference 
material for a document, including bibliographies, cross-references, indexes, and tables 
of authorities (which are used in legal documents). Most of the tools you use for these 
tasks appear on the ribbon’s References tab. 

In the first section of this chapter, you’ll learn details about tracking revisions in a 
document, including how to merge different versions of a document and review 
revisions in the combined document.

3.1	 Review, Compare, and Combine Documents
In this section, you learn how to work with four groups of commands on the Review 
tab: Comments, Tracking, Changes, and Compare. You often use these commands 
when you work on a shared document with colleagues or coworkers, but you can use 
them effectively on your own when you need to annotate a document or compare and 
combine different versions of a document.
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Adding Comments to a Document
A simple way to annotate a document is to insert comments. You might use a comment 
to indicate that a section needs revising, that information is missing, or that certain facts 
need to be checked. One advantage of using comments (rather than revision marks) is 
that they appear in context but are not integrated with the document’s content. Each 
comment is numbered and identified by initials associated with the user who inserts 
it (using the initials specified on the General tab in the Word Options dialog box). You 
can move from comment to comment by using the Previous and Next buttons in the 
Comments group. Use the Delete command to remove a comment (or all comments at 
once) when a comment is no longer needed.

You can see comments in balloons and in the Reviewing pane.

Tip  To reply to a comment, place the cursor in a comment balloon and then click New 
Comment. Word identifies the new comment by adding R to the comment’s ID. The R tells 
you that this comment is a reply to the comment that precedes it.
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You can view comments in balloons in the Print Layout, Full Screen Reading, and Web 
Layout views. In Draft and Outline views, comments are displayed in ScreenTips when 
you rest the mouse pointer on the highlighted text. You can also view comments in 
the Reviewing pane. Other options for displaying comments are available in the Track 
Changes Options dialog box, which is covered in the next section.

➤ To insert, review, and delete comments

	 1.	 On the Review tab, in the Comments group, click New Comment, and then type 
the comment. 

Depending on which document view you are using, you will enter the comment in 
a balloon or in the Reviewing pane.

	 2.	 To move from comment to comment, click Next or Previous in the Comments 
group.

	 3.	 To delete a comment, select the comment and then click Delete in the Comments 
group.

You can also delete all comments shown or all the comments in a document.

➤ To reply to a comment

	 1.	 Select the comment you want to reply to.

	 2.	 On the Review tab, click New Comment, and then type the reply.

Using Track Changes and Setting Track Changes Options
Tracking revisions that you or other users make to a document can be simple and 
straightforward. Click Track Changes on the Review tab, and then the insertions, 
deletions, and text moves you make in the document are highlighted, along with 
changes to formatting. You can then use the commands in the Changes group to find 
revisions and to accept or reject them.

You can also choose from a number of options for how revisions are tracked and 
displayed and how you view them. Many of these settings are controlled in the Track 
Changes Options dialog box.
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In the Track Changes Options dialog box, you can specify the following:

●	 Formatting that Word applies to insertions and deletions.

●	 Where Word places a line that indicates where a change was made.

●	 The color that identifies your changes or whether changes are specified by author.

●	 The background color for comment balloons.

●	 Whether and how Word tracks text that is moved.

●	 Highlighting for changes to table cells.

●	 Whether changes to formatting are tracked and how Word displays those changes.

●	 The size and position of comment balloons and whether Word displays a balloon 
for all types of changes, never uses balloons, or displays balloons only for com-
ments and formatting changes. You can also specify whether Word shows a line 
that connects a balloon to the text it refers to.

●	 How Word orients the page when you print a document with revisions and 
comments.
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Tip  Changes you make to a document are identified by the user name and initials 
entered in the Word Options dialog box. For some documents, you might want to be 
identified by your role or with a user name other than the one currently set. For example, 
you might want to associate revisions with the user name Engineering if you are reviewing 
a document on behalf of that department. You can change your identity from the Review 
tab by clicking Track Changes, Change User Name. Enter the user name and initials you 
want to use, and then click OK. Note, however, that any change you make is carried 
over to other documents. You should revert to your standard user name and initials as 
necessary.

Use the list of views available on the Display For Review menu (at the top of the Tracking 
group) to show or hide revisions:

●	 Final: Show Markup  The default option, which shows the final document with 
insertions, deletions, and comments.

●	 Final  Shows how the document appears if you accept all revisions.

●	 Original: Show Mark  Shows the original document with insertions, deletions, and 
comments.

●	 Original  Shows the original document without any revisions that have been made 
(as the document would appear if all revisions were rejected).

Because the Final and Original options let you see a document without its revision marks, 
you can use these options to read through passages of heavily revised text more easily.

The Show Markup menu lets you control the display of specific items. For example, in a 
document in which formatting changes have been tracked from start to finish, clear the 
check mark for Formatting to suppress the corresponding balloons or other highlighting. 
Word shows changes by all reviewers of a document by default. If you want to see the 
changes made by a specific reviewer or a particular set of reviewers, click Reviewers, click 
All Reviewers to remove the check mark, and then open the menu again and select the 
reviewer or reviewers whose work you want to inspect.

Display the Reviewing pane in horizontal or vertical layout so that you can see the 
collection of revisions made to a document. The Reviewing pane also shows a set of 
statistics about how many of each type of change the document contains.

See Also  For information about accepting or rejecting changes, see “Reviewing a 
Combined Document” later in this chapter.
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➤ To track changes and set track changes options

	 1.	 On the Review tab, click Track Changes in the Tracking group.

Word highlights the Track Changes command to indicate that the feature is active. 

	 2.	 On the Review tab, click Track Changes and then click Change Tracking Options.

	 3.	 In the Track Changes Options dialog box, change the settings for how insertions 
and deletions should be marked, whether and how to track text moves and format-
ting changes, and which changes Word should display a balloon.

	 4.	 Use the Display for Review menu to choose whether to see the final or original 
document, with our without markup.

	 5.	 On the Show Markup menu, select or clear the check marks for which elements of 
the document markup you want to view (including comments, insertions and dele-
tions, and formatting).

	 6.	 Click Show Markup, Reviewers to see only the changes made by a specific reviewer 
or set of reviewers.

Merging Documents
If you have two or more versions of a document that you want to compare or bring 
together, click Compare on the Review tab. Use the first option on the menu that Word 
displays to compare two versions of a document. (Word also calls this a legal blackline, 
a method of showing only what is different between two versions of the document.) In 
the Compare Documents dialog box, you point to the original document and the revised 
document, choose settings for the types of changes Word will mark, and specify whether 
Word will show the results of the comparison in the original document, the revised 
document, or a new document.

The second option on the Compare menu is Combine, which is more fully identified 
as Combine Revisions From Multiple Authors Into A Single Document. The Combine 
Documents dialog box is set up essentially the same as the Compare Documents 
dialog box.

When you click OK in the Combine Documents dialog box, Word is likely to display a 
message box telling you that only one set of formatting changes can be stored in the 
merged document. You need to choose between the changes in the original document 
and the revised document to continue merging the documents. Word displays the results 
of combining the documents in a set of windows that shows the combined document 
in a central pane and the original and revised documents in smaller panes at the right. 
Word also displays the Reviewing pane along the left side of the window.
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The Character Level option shows changes in capitalization 
and other letter-by-letter changes.

Clear check 
boxes in the 
Comparison 
Settings area 
for items Word 
can skip when 
it combines two 
documents.

If you need to, you can merge another version of the document at this point by choosing 
Combine from the Compare menu again, pointing to the combined result document 
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(Combine Result 2 in the preceding screen shot) as the original document, and selecting 
the next version you want to combine.

To save the combined result, click Save on the Quick Access Toolbar (or click File, Save) 
and then name the combined document. You can then open the combined document 
and work through the variations (indicated by revision marks), accepting and rejecting 
them as necessary, to achieve a final document.

➤ To combine two or more documents into a single document

	 1.	 Open a blank document in Word. (You can also start with the original document or 
one of the revised documents open.)

	 2.	 On the Review tab, in the Compare group, click Compare, Combine.

	 3.	 In the Combine Documents dialog box, select the original document (if it isn’t 
already selected) by choosing it from the drop-down list or by clicking the folder 
icon and browsing to the location where the document is saved.

	 4.	 Select the revised document you want to combine with the original document.

	 5.	 If necessary, click More to display the Comparison settings area and other options 
in the dialog box.

	 6.	 In the Comparison settings area, clear or select the check boxes to specify the 
document elements you want Word to use in its comparison.

	 7.	 In the Show changes at area, choose the option to show changes at the character 
level or the word level.

	 8.	 In the Show changes in area, choose an option for where Word will show changes: 
in the original document, the revised document, or a new document.

Reviewing a Combined Document
In the window that Word displays after you combine documents, you can scroll through 
the combined document and the original and revised documents at the same time. Your 
location in each document is synchronized, which lets you refer to any of the documents 
as you need to.

In the Reviewing pane, you can right-click an insertion or a deletion and then accept or 
reject it. Working in the Reviewing pane can be cumbersome. If you prefer to work in 
the document itself, close the Reviewing pane (by clicking the X in the pane’s upper-right 
corner or clicking Reviewing Pane on the Review tab).
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If you close the Reviewing pane, you can use commands in the Changes group to 
navigate from change to change (by clicking Previous or Next) and to accept or reject 
the changes showing in the combined document. The Accept and Reject menus have 
similar sets of commands: Accept and Move To Next, Accept Change, Accept All Changes 
Shown, and Accept All Changes In Document. The Accept (or Reject) All Changes Shown 
command is active only when you select an option other than All Reviewers from the 
Show Markup, Reviewers menu.

Tip  You can also right-click a change in the combined document and then click Accept 
Change or Reject Change in the menu that appears.

➤ To review changes in a combined document

	 1.	 In the Reviewing pane, right-click in a heading marked Inserted or Deleted and 
then choose the Accept or Reject option from the menu that appears.

Or follow these steps:

	 2.	 On the Review tab, in the Changes group, click Next to move to the next revision.

	 3.	 In the Changes group, click the arrow under Accept (or under Reject) and then 
click Accept Change or Reject Change.

	 4.	 Click Accept and Move to Next to accept the revision and move directly to the 
next one. Click Reject and Move to Next to reject a revision and move to the next 
one.

	 5.	 To accept or reject all revisions at once, click the arrow under Accept (or Reject) 
and then click Accept All Changes in Document or Reject All Changes in 
Document.

➤ To accept or reject revisions made by a particular reviewer or set of reviewers

	 1.	 On the Review tab, in the Tracking group, click Show Markup, Reviewers.

	 2.	 Clear the check mark next to All Reviewers, and then repeat step 1 and select the 
first (or only) reviewer whose revisions you want to see. Repeat step 1 again to 
select any other reviewer.

	 3.	 In the Changes group, click the arrow under Accept (or Reject) and then click 
Accept All Changes Shown or Reject All Changes Shown to work with this group 
of revisions all at once.

You can also move from revision to revision in the set that is shown and accept or 
reject revisions one at a time.
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Practice Tasks

The practice files for these tasks are located in the practice files folder for Microsoft 
Word 2010. You can save the results of these exercises in the same folder. Change 
the file name so that you don’t overwrite the sample files. When you are done, try 
performing the following tasks:

●	 Open the file SpringCatalog2012.docx, and make some revisions to this file 
and insert comments. For example, insert a table that you can use as the basis 
for an order form. Include columns such as Title, Price, and Quantity. Insert 
the titles of a few books or other publications you like as placeholders. Use 
the Save As command to save a new copy of this document.

●	 Create a new blank document in Word. Open the Combine Documents dialog 
box, and then point to the file SpringCatalog2012.docx as the original docu-
ment. Merge the version of the document you created in the first step of this 
exercise to create a combined document.

●	 Open the Combine Documents dialog box again, and merge the document 
SpringCatalog2012_marketing.docx with the combined document you have 
already created.

●	 Save the combined document, open it in its own window, and then accept or 
reject one or more of the changes.

3.2	 Create a Reference Page
Research and scholarly documents, and even many types of longer business documents, 
include citations to sources that the authors of the documents referred to in developing 
their ideas and performing their investigations and analyses. The References tab in Word 
2010 provides tools that let you build a list of sources (using the information required 
by conventional authorities such as the Modern Language Association or the Chicago 
Manual of Style), manage these sources, and insert the citations where you need them in 
a document. When the citations are in place, you can easily create a bibliography or a list 
of works cited.

Word also provides a mechanism for creating and managing cross-references in a 
document. To aid navigation within a document, you can link a cross-reference to the 
element it refers to. Word also updates cross-references so that the information they 
refer to, such as section headings or page numbers, is kept up to date automatically.
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Adding Citations to a Document
To add and define citations for a document, you work with the commands in the 
Citations & Bibliography group on the References tab. Word provides a number of 
built-in citation styles that you can choose from. These styles conform to conventions 
defined by organizations and in traditional style manuals. For example, the style list 
includes entries for the fifth edition of the American Psychological Association’s style 
guide (APA Fifth Edition), the Modern Language Association (MLA Sixth Edition), and the 
fifteenth edition of the Chicago Manual of Style. The style you select here determines 
what information you enter for a citation.

Use the Style list to select 
a citation style for a document.

You can use the Insert Citation command to add a citation that’s already defined, to 
create a new source for a citation, or to enter a placeholder for a citation. You can return 
to a placeholder later when you need to fill in details for the source.

In the Create Source dialog box, first select the type of source (for example, book, 
conference proceedings, interview, or sound recording). The fields in the Create Source 
dialog box change to reflect the type of source you select. Word displays a simple 
example for each field when you select that field.

Select Show All Bibliography Fields to display fields 
for information such as volume, translator, and short title.
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To create an entry with multiple authors, click Edit beside the Author field and then 
use the Edit Name dialog box to add each author name required for the citation. Word 
creates a tag name on the basis of the author name you enter. 

Each citation you define is included in a gallery that appears when you click Insert 
Citation. Select a citation from that gallery when you need to insert it. To fill in the 
details for a placeholder, right-click the content control for the placeholder and click Edit 
Source. You can also use the Edit Source command to change the details of a citation 
inserted in the document.

To make changes to a citation itself, click the down arrow that appears on the citation’s 
content control. The menu that appears provides options that let you edit the citation, 
edit the details for the source that is cited, convert the citation to static text, and update 
the citations and bibliography in the document.

When you work in the Edit Citation dialog box, you can add page references for the 
citation and choose to display the author, year, and title or suppress the display of one or 
more of these elements.

In the Edit Citation 
dialog box, you can 
specify the information 
that appears in the 
citation.

➤ To insert a new citation

	 1.	 On the References tab, in the Citation & Bibliography group, choose the style of 
citation you want to use.

	 2.	 Position the cursor where you want the citation to appear, and then click Insert 
Citation, Add New Source.

	 3.	 In the Create Source dialog box, select the type of source and then fill in the fields 
shown.

	 4.	 Select Show All Bibliography Fields if you need to enter additional details for the 
source.
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➤ To use a citation placeholder

	 1.	 Position the cursor where you want the citation to appear, and then click Insert 
Citation, Add New Placeholder.

	 2.	 In the Placeholder Name dialog box, keep the default title provided or type a tag 
name for the source.

	 3.	 To fill in the source details, right-click the placeholder and then click Edit Source.

	 4.	 In the Edit Source dialog box, select the type of source and then fill in the fields 
required.

Managing Sources
When you define the details for a source in the Create Source dialog box, Word adds the 
reference to a master list of sources. To work with this list, you use Source Manager. 

Use the Search and Sort boxes in Source Manager to quickly find 
a source or to arrange the sources by title instead of author.

Tip  Instead of providing details for each citation as you insert them, you can build a list 
of sources in Source Manager. Open Source Manager, and then use the Create Source 
dialog box (by clicking New in Source Manager) to provide the details for each source 
you need to cite. Then return to the document and place citations where you need them 
by using the entries in the Insert Citation gallery.
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Source Manager shows two lists of sources: the master list and the list for the current 
document. You can copy sources from the master list when you need to cite them in 
the current document. (You can also copy a source in the list for the current document 
to the master list.) Use the other command buttons in Source Manager to edit source 
information or to delete a source. You cannot delete a cited source (indicated by a check 
mark) from the current list of sources. 

Word stores the sources you define in a file named Sources.xml. To see this file, click the 
Browse button in Source Manager to display the Open Source List dialog box. You can 
copy this file and use it on another computer or share it with other users. To add sources 
from this file to Source Manager, display the Open Source List dialog box, select Sources.
xml, and then click Open. But be warned that this will replace any existing definitions of 
the currently logged on user.

➤ To manage sources for a document

	 1.	 On the References tab, in the Citation & Bibliography group, click Manage 
Sources.

	 2.	 In the Source Manager dialog box, click Copy to move a source from the master 
list to the current list.

	 3.	 Select a source, and then click Delete to remove a source from a list.

	 4.	 Select a source, and then click Edit to update or revise details for the source.

	 5.	 Click New to open the Create Source dialog box and define a new source.

	 6.	 To change the sort order for the source lists, select an option from the Sort list.

	 7.	 To search for a particular source or set of sources, type the search string in the 
Search box.

Creating a Bibliography
To insert a bibliography that lists the sources cited in a document, click Bibliography in 
the Citations & Bibliography group. Word displays a gallery from which you can insert a 
list of sources that is labeled Bibliography or a list that uses the label Works Cited. Choose 
Insert Bibliography to insert a simply formatted bibliography. 

Because bibliographies are a type of building block, you can change the formatting for 
the bibliography you insert, and then select it and save it to the Bibliography gallery to 
use in other documents.
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See Also  For more information about creating custom building blocks, see “Construct 
Reusable Content in a Document“ in Chapter 2 in this part of the book.

➤ To insert a bibliography or a list of works cited

	 1.	 Position the cursor where you want the bibliography to appear.

	 2.	 On the References tab, in the Citation & Bibliography group, click Bibliography, 
and then choose the option you want from the gallery that appears.

➤ To save a bibliography to the Bibliography gallery

	 1.	 Insert the bibliography for the document.

	 2.	 Make any formatting changes you want to the bibliography entries.

	 3.	 Select the bibliography, and then click Bibliography, Save Selection to 
Bibliography Gallery.

	 4.	 In the Create New Building Block dialog box, type the name and description for 
this bibliography, specify its gallery and the template you want to save it in, and 
then click OK.

Using Cross-References in a Document
Cross-references let you easily locate specific content within the current document, and 
they also help keep numbered items (numbered tables and figures, for example) and 
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page references up to date. By default, Word lets you define cross-references to the 
following elements of a document:

●	 A numbered item  Paragraphs that use Word’s automatic numbering styles

●	 Heading  A paragraph styled with one of Word’s built-in heading styles or a style 
based on those styles

●	 Bookmark  A bookmark defined in the document

●	 Footnote or endnote  Notes you insert by using commands in the Footnote group 
on the References tab

●	 Equation  An equation associated with a Word caption

●	 Figure  An illustration or other figure associated with a Word caption

●	 Table  A table associated with a Word caption

Creating a Caption
Judging by the last three items in the preceding list, you shouldn’t be surprised to find 
the Cross-Reference command in the Captions group on the References tab. (It also 
appears in the Links group on the Insert tab.) When you want to label an equation, a 
figure, or a table (or any other element you want to refer to in a document), select the 
object and then click Insert Caption.

Click New Label to define a label 
that you can assign to other elements 
you want to cross-reference.

In the Caption dialog box, use the Label list to select the type of object you are adding 
a caption to. The default choices are equation, figure, and table. You can define other 
labels as you need them by clicking New Label. (You can delete custom labels when you 
no longer need them, but you cannot delete the default options.)
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Type the text for the caption (making sure you include a space after the default label 
that’s shown). Click the Numbering button to display the Caption Numbering dialog box, 
and then use this dialog box to switch to a different numbering format or to include a 
chapter number with a caption’s label. (Chapters must be defined by using one of Word’s 
built-in heading styles.)

AutoCaptions

If you need to insert a particular type of object repeatedly in a document and you 
want these objects to have a caption, click AutoCaption in the Caption dialog box. 
Select the object types (Bitmap Image or Microsoft Excel Worksheet, for example) 
for which you want Word to provide a caption automatically when you insert an 
object of this type. You can adjust the label that’s used with a particular type of 
object and where Word positions the caption by default.

Inserting a Cross-Reference
With the cursor positioned where you want to add a cross-reference, type some text 
that introduces the object you are cross-referencing (for example, For a summary 
of the amino acids analyzed, see). Open the Cross-Reference dialog box, and then 
select the type of reference. For example, to reference a table, select that entry from the 
Reference Type list, and then Word displays a list of tables in the document (those tables 
labeled with a caption created in Word). With the type of reference selected, use the 
Insert Reference To list to choose the reference format—a page number, for example, or 
the text of a heading—and then choose the item you are referring to in the For Which 
Caption list.
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For some types of references (headings or bookmarks, for example), the Insert Reference 
To list includes two types of numbers: No Context and Full Context. These options are 
used with lists or outlines that use multiple levels. The Full Context option includes each 
element in a numbering scheme—for example, 4.1.1.a. The No Context alternative refers 
only to the last of the levels used.

Select the Include Above/Below option to insert a positional cross-reference that uses 
the word above or below depending on where the item you are referring to is located in 
relation to the reference. 

Keep the Insert As Hyperlink check box selected if you want to create a hyperlink 
from the cross-reference to the reference’s target. The hyperlinks you create in the 
Cross-Reference dialog box work in Word and in a browser if you save a document as a 
web page.

➤ To create a caption for a document element

	 1.	 Select the object you want to create a caption for.

	 2.	 On the References tab, in the Captions group, click Insert Caption.

	 3.	 In the Caption dialog box, in the Label list, select the type of object.

	 4.	 In the Position list, select an option for where you want the caption to appear.

	 5.	 Click Numbering to open the Caption Numbering dialog box, in which you can 
adjust number formatting for the caption.

	 6.	 Type the caption after the label in the Caption box, and then click OK.

➤ To insert a cross-reference

	 1.	 Type the text you want to use to introduce the item you are referencing.

	 2.	 On the References tab, in the Captions group, click Cross-reference.

	 3.	 In the Cross-reference dialog box, select the reference type.

	 4.	 In the Insert reference to list, select which option you want to use as the reference 
(page number, caption, section heading, for example).

	 5.	 In the For which caption list, select the target for the cross-reference.

	 6.	 Click Insert.
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Practice Tasks

The practice files for these tasks are located in the practice files folder for Microsoft 
Word 2010. You can save the results of these exercises in the same folder. Change 
the file name so that you don’t overwrite the sample files. When you are done, try 
performing the following tasks:

●	 Use the sources listed in the file PracticeSources.docx to create a list of six or 
seven sources in Source Manager.

●	 Open the file Citations.docx, and insert citations to the sources you defined. 
Insert several placeholders for citations as well.

●	 Open Source Manager, and edit information for three of the sources listed. 
Choose one or more of the entries for the placeholders you inserted, and 
then use the file PracticeSources.docx to enter details for those placeholders.

●	 Insert a bibliography for the file Citations.docx.

●	 Open the file X-refs.docx, which contains several tables and figures, along 
with section headings. Create captions for the tables and figures, and then 
insert cross-references to several of the elements in the file.

3.3	 Create a Table of Authorities in a Document
Tables of authorities are used in legal documents as a reference to the cases, statutes, 
rulings, regulations, and other citations included in a document. Word can generate a 
table of authorities on the basis of the citations you mark and define in a document. 
Word’s table of authorities feature provides several built-in categories that you use 
to classify citations, but you can modify this list or add categories of your own. Word 
also lets you choose options for formatting a table of authorities and for how the table 
displays the citations.

Marking Citations
To start building a table of authorities, select the text of a citation in the document and 
then click Mark Citation in the Table Of Authorities group on the References tab. The 
text you select appears in the Selected Text box and the Short Citation box in the Mark 
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Citation dialog box. You can edit the citation’s text in the Selected Text box or in the 
Short Citation box. To change the formatting of the text, right-click in the Selected Text 
box and then choose Font.

Clicking Next Citation takes you to 
the next location that Word thinks 
is a citation you need to mark.

Word provides seven named categories by default (cases, statutes, other authorities, 
rules, treatises, regulations, and constitutional provisions), along with unspecified 
categories numbered 8 through 16. You can replace a named category or assign a name 
to a numbered category to modify what Word provides.

When you click Mark in the Mark Citation dialog box, Word adds the citation to a list. 
Click Mark All, and Word inserts a “table of authorities” field (identified by the characters 
TA) for each instance in the document that matches the text in the long and short forms 
you define. You can keep the Mark Citation dialog box open as you navigate through 
a document to mark other citations. The Next Citation button moves to the next likely 
citation in the document—Word uses clues such as “v.” or dates in parentheses—for 
example, (2001)—to identify citations.
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Formatting and Aligning a Table of Authorities
When you are ready to build your table of authorities, position the cursor where you 
want the table of authorities to appear, then click Insert Table Of Authorities on the 
References tab.

In the Table Of Authorities dialog box, you can set the following options:

●	 Category  Select which category of authorities you want to include, or choose All. 
You cannot choose more than one option in this list.

●	 Use Passim  Keep this check box selected if you want to use the term passim to 
indicate that information the citation refers to is scattered throughout the source. 
Clear this check box to list specific pages.

●	 Keep Original Formatting  Use this option to specify whether the citations listed in 
the table of authorities appear in the table as they are formatted in the document.

●	 Tab Leader  Choose the type of tab leader to use (which helps align page 
numbers), or choose None from this list.

●	 Formats  Choose a style for the table of authorities, or use the styles and 
formatting that is defined in the current template.

To change formatting for the table of authorities entries and the table heading, use the 
From Template setting in the Formats list, and then click Modify to open the Style dialog 
box. Select the element you want to change, click Modify in the Style dialog box, and 
then revise the formatting in the Modify Style dialog box.
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➤ To mark table of authorities citations

	 1.	 In the document, select the text for a citation.

	 2.	 On the References tab, in the Table of Authorities group, click Mark Citation.

	 3.	 In the Mark Citation dialog box, edit the text for the citation in the Selected text 
box. 

	 4.	 Edit the short form for the citation in the Short citation box.

	 5.	 In the Category list, select a category for the citation.

	 6.	 Click Mark, or click Mark All, to insert a table of authorities reference for each 
instance of this citation as you have defined it in the Mark Citation dialog box.

	 7.	 Click Next Citation, and repeat steps 3 through 6.

➤ To format and generate a table of authorities

	 1.	 Position the cursor where you want the table of authorities to appear in the 
document.

	 2.	 On the References tab, in the Table of Authorities group, click Insert Table of 
Authorities.

	 3.	 In the Table of Authorities dialog box, do the following:

❍	 Select the category of citation you want to create a table for, or select All.

❍	 Select or clear the Use Passim check box to use the term passim for 
short-form references or to show specific page numbers referred to in 
the citation.

❍	 Select or clear the Keep original formatting option to maintain the format-
ting defined for the citation in the Mark Citation dialog box.

❍	 Select a tab leader to use to align page numbers.

❍	 Select a format for the table, or choose From template.

	 4.	 Click OK. (If the field code appears, right-click and select Toggle field codes.)

➤ To replace a category for a table of authorities

	 1.	 On the References tab, click Mark Citation.

	 2.	 In the Mark Citation dialog box, click Category.

	 3.	 In the Edit Category dialog box, select the category you want to change.

	 4.	 In the Replace with box, modify the category name.

	 5.	 Click Replace.

	 6.	 Make changes to other categories as necessary, and then click OK.
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➤ To modify styles for table of authorities entries

	 1.	 In the Table of Authorities dialog box, select From template in the Formats list.

	 2.	 Click Modify.

	 3.	 In the Style dialog box, select the element you want to change—Table of 
Authorities (for entries) or TOA Heading.

	 4.	 In the Style dialog box, click Modify.

	 5.	 In the Modify Style dialog box, make changes to the style and then click OK.

	 6.	 Click OK to close the Style dialog box.

Practice Tasks

Tables of authorities are used specifically in legal documents. No special practice 
files have been included with this book, but you can use one of your own to build a 
table of authorities in Word by using the techniques you learned in this section.

3.4	 Mark and Compile an Index for a Document
To create an index in a document, you need to complete two general steps: mark index 
entries in the file, and set options for how Word generates the index. You can find details 
about specifying index options in “Setting Index Options” later in this section. In the next 
section, you’ll learn the mechanics of marking index entries.

Marking Index Entries
You can follow any of several approaches for marking index entries. You can select 
text in a document to use as an entry, insert an entry of your own where you want the 
index marker to appear, or insert index markers by importing a list of terms set up in an 
AutoMark file.

To mark entries in the file, begin by clicking Mark Entry in the Index group on the 
References tab to open the Mark Index Entry dialog box. 

In the file, select a word or phrase you want to add as a main index entry and then click 
the dialog box to make it active. The text you select appears in the Main Entry field. You 
do not need to select text in the document to use as the main entry. You can also place 
the cursor where you want an index entry to appear and then type the main entry as a 
starting point.
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You can edit the text for the entry and type a subentry if applicable. To include a third-
level entry, type the subentry text followed by a colon (:), and then type the text of the 
third-level entry. In the Options area, select Cross-Reference and then type a reference 
to other index entries as applicable.

Use text in the 
document to 
start a main 
entry or type a 
main entry 
yourself.

Tip  To format the text for the index, select the text in the Main entry or Subentry box, 
right-click, and then click Font. Select the formatting options you want to use.

If this entry relates to the specific instance of this text on the current page, keep the 
Current Page option selected. To specify a page range for an entry, you first need to 
create a bookmark. Select the paragraphs in the range you want to use, and then use the 
Bookmark dialog box (which you can open by clicking Bookmark in the Links group on 
the Insert tab) to define the bookmark. In the Mark Index Entry dialog box, choose Page 
Range and then select the bookmark you defined for that range.

Use the options provided for formatting the page number in bold or italic, and when the 
entry is complete, click Mark to define it. Click Mark All to insert an index field for each 
occurrence of the main entry you defined in the document.
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When you select text and mark it as an index entry, Word adds an index entry field. The 
field is identified by the characters XE and encloses all the information for an entry in 
curly braces. If you don’t see the index fields in your document, click Show/Hide (the 
paragraph icon) in the Paragraph group on the Home tab. Here is an example of the 
information you might see for an index field:

{ XE “formatting:characters: font” \t See also styles” }

Another method for identifying the terms for an index is to list main entries in a separate 
file that Word uses to mark your document. You can set up the entries in a two-column 
table—with the terms you want to search for in the left column and the corresponding 
entries in the right column—or use a single list. The entries in this list are case sensitive. 
For example, if you are searching for the term text effects, Word won’t insert an index 
field if the AutoMark file includes only an entry Text effects. To insert the entries, click 
Insert Index on the References tab, click AutoMark in the Index dialog box, and then 
select the file that lists the terms in the Open Index AutoMark File dialog box.

Setting Index Options
After you mark all the index entries, you use the Index dialog box to choose an index 
design and select other options. 
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For example, Word supports two types of indexes: indented and run-in.

In a run-in index, main entries and subentries are formatted as follows:

Styles: applying, 211; creating, 209; updating 
  in template, 212. See also character formatting

In an indented index, the entries are listed in this format:

Styles 
  applying, 211 
  creating, 209 
  updating in template, 212 
  See also character formatting

When the length of an index is a factor, you save space by using a run-in index. When 
you select an option for the type of index, Word displays an example in the Print Preview 
area of the Index dialog box.

By default, Word creates a two-column index. You can choose the Auto setting or set the 
number of columns from 1 to 4. Choose the language you want to use as necessary. If 
you are setting up an indented index, you can change the alignment of page numbers 
by selecting the Right Align Page Numbers check box. Word previews this format when 
you select the option, and you can then select the type of tab leader you want to include 
(or select None from this list). The Formats list provide several options for the fonts, line 
spacing, and other styles Word applies when you generate the index.

If you keep From Template selected in the Formats list, click Modify in the Index dialog 
box to open the Style dialog box, which lists the styles for index levels 1 through 9. 
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Select an index level, and then click Modify to open the Modify Style dialog box and 
make changes to formatting attributes for that style.

See Also  For more information about modifying styles, see “Apply Advanced Font and 
Paragraph Attributes” in Chapter 2 in this section of the book.

When you finish defining options for the index, place the cursor where you want the 
index to appear, and click OK. Word sorts the entries alphabetically, adds page number 
references, and removes duplicate entries that occur on the same page.

Editing and Updating an Index
If you need to edit an index entry, you should edit the specific index marker and not the 
index that Word generates. Locate the field, and then edit and format the text within the 
quotation marks inside the curly braces that define the field. (Click Show/Hide on the 
Home tab if you don’t see the fields in the document.) 

To delete an index marker, select the field (including the braces) and press Delete.

When you need to edit an index, open the Find And Replace dialog box (by clicking Find, 
Advanced Find in the Editing group on the Home tab). Click Special (or first click More if 
you don’t see the Special button), and then select Field. Click Find Next to move to the 
first field. To continue from field to field, click Find Next again, or close the dialog box 
and press Shift+F4.

After you revise the index entries, click F9 or click Update Index on the References tab.

➤ To mark index entries

	 1.	 On the References tab, in the Index group, click Mark Entry.

	 2.	 In the document, select the text for a main entry, and then click the Mark Index 
Entry dialog box to make it active. You can also position the cursor where you want 
an entry to appear, and then type the entry in the Main Entry box.

	 3.	 In the Subentry box, type a subentry (if needed). To define a third-level entry, add 
a colon to the end of the subentry, and then type the third-level entry.

	 4.	 To add a See or See Also reference, select Cross-reference and then type the text 
for the reference.

	 5.	 To specify a page range for an entry, click Page Range and then choose the book-
mark for the range. (See the next procedure for the steps you follow to create a 
bookmark.)
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	 6.	 In the Page number format area, select bold and italic formatting as required.

	 7.	 Click Mark. Click Mark All to mark all instances of this entry in the document.

➤ To define a bookmark for a page range

	 1.	 Select the paragraphs you want to include in the page range.

	 2.	 On the Insert tab, in the Links group, click Bookmark.

	 3.	 In the Bookmark dialog box, type a name for the bookmark and then click Add.

➤ To create an index from an AutoMark file

	 1.	 Create the AutoMark file using a two-column table. Specify the terms you want 
Word to search for in the left column. Add the corresponding index term to the 
right column. 

	 2.	 On the References tab, in the Index group, click Insert Index.

	 3.	 In the Index dialog box, click AutoMark.

	 4.	 In the Open AutoMark File dialog box, select the file and then click Open.

➤ To specify index formatting options and generate the index

	 1.	 In the document, insert your cursor where you want the index to appear.

	 2.	 On the References tab, in the Index group, click Insert Index.

	 3.	 In the Index dialog box, set the following options. Refer to the Print Preview area 
of the dialog box to see the effects of your selections.

❍	 Select a type of index: indented or run-in.

❍	 Specify the number of columns.

❍	 Choose a language if you are using a language other than the default 
language on your system.

❍	 If you are using an indented index, click Right align page numbers (an 
optional choice) and then select the style of tab leader you want to use.

❍	 Select a format for the index, or keep From template selected.

	 4.	 Click OK in the Index dialog box.

➤ To modify index styles

	 1.	 In the Index dialog box, select From template in the Formats list.

	 2.	 Click Modify.
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	 3.	 In the Style dialog box, select the index level whose style you want to change and 
then click Modify.

	 4.	 In the Modify Style dialog box, make changes to the style and then click OK.

	 5.	 Click OK in the Style dialog box.

➤ To edit and update an index

	 1.	 In the document, click Show/Hide if the index fields are not displayed.

	 2.	 Select the text in the index field, and revise and format it as you need to.

	 3.	 Press F9 or click Update Index on the References tab.

Practice Tasks

The practice files for these tasks are located in the practice files folder for 
Microsoft Word 2010. You can save the results of these exercises in the same folder. 
Change the file name so that you don’t overwrite the sample files. When you are 
done, try performing the following tasks:

●	 Open the file Chapter02.docx, which is an abbreviated version of the Word 
file for Chapter 2 in this section of the book. Work through three or four 
pages of the file, and add index entries for terms such as formatting, styles, 
text effects, and others. Add any applicable subentries, and define page 
ranges using bookmarks. Use the Index dialog box to set formatting options 
for the index, and then generate the index in Word. Edit a handful of entries 
using the field tags, and then update the index to reflect your changes.

Objective Review
Before finishing this chapter, be sure that you have mastered the following skills:

3.1	 Review, compare, and combine documents
3.2	 Create a reference page
3.3	 Create a table of authorities in a document
3.4	 Mark and compile an index for a document
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	 4	 Working with
		  Macros and Forms 
The skills tested in this section of the Microsoft Office Expert exam for Microsoft Excel 
2010 relate to using macros and forms, including how to record and run a macro and 
how to insert controls to build a form. Specifically, the following objectives are associated 
with this set of skills:

4.1	 Create and manipulate macros
4.2	 Insert and manipulate form controls

Important  The topics and procedures in this chapter refer to command groups on 
the Developer tab. If the Developer tab is not displayed on the ribbon, click Options 
on the File tab, click Customize Ribbon in the Excel Options dialog box, and then select 
Developer in the list of main tabs.

4.1  Create and Manipulate Macros
A macro in Excel can perform an operation as routine as adding your company address 
to a worksheet or printing a worksheet with specific settings. You could record a macro 
that enters a series of dates, months, or other periods of time in a worksheet row, aligns 
the cell data, and then applies formatting to the cells. Macros can, of course, be used 
to do many other tasks, especially once you learn how to enhance the operations of 
a macro you record or write macros from scratch by using Microsoft Visual Basic for 
Applications (VBA).

When working with macros in Excel, keep in mind that the default file format—Excel 
Workbook (.xlsx)—does not support macros. If you record or write a macro in a work-
book and try to save the workbook as an .xlsx file, Excel displays a message indicating 
that you can’t include the macro. To include macros in a workbook, you must save the 
workbook in the Excel Macro-Enabled Workbook (.xlsm) format or as a macro-enabled 
template (.xltm). You can also use the Excel 97–2003 Workbook (.xls) format, but that 
format does not support many of the features in Excel 2010.
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You’ll see this message if you try to save a macro in a macro-free file format. 
Use the macro-enabled workbook format (.xslm) instead.

 

Tip  You can change the default file format in which workbooks are saved to a format 
that supports macros by opening the Excel Options dialog box from the File tab, 
displaying the Save page, and then selecting the format you want in the Save Files In 
This Format list.

You can run the macros in a workbook in a variety of ways, which lets you choose the 
option that fits the situation at hand. For a macro you want to apply to every workbook, 
you can add a button that runs the macro to the Quick Access Toolbar or to a custom 
group on the ribbon. You can also define a macro that runs whenever a workbook is 
opened or run a macro by using a keystroke.

See Also  For general information about customizing the ribbon, see “Modifying the 
Display of the Ribbon” at the beginning of this book. 

In the following sections, you’ll learn details about recording a macro and about 
different ways you can run a macro.

See Also  For information about assigning a macro to a command button that you add to 
an Excel worksheet, see “Inserting Form Controls” later in this chapter.

Recording and Storing a Macro
In the Record Macro dialog box, you should first provide a name for the macro you’re 
recording. (You can accept the default name that Excel displays, but providing your own 
descriptive name is more useful.) You must begin a macro name with a letter; you can 
include numbers later in a macro’s name. Macro names cannot include spaces. Use an 
underscore character to separate words or use interior capitalization (for example,  
My_new_macro or MyNewMacro).

See Also  For more information about assigning a shortcut key, see “Assigning a 
Keystroke to a Macro” later in this chapter.
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Use the Store Macro In list to specify whether 
you want access to the macro globally or only 
in the current workbook. 

By default, Excel first displays This Workbook in the Store Macro In list. Keep this option 
if you want the macro to be available only in this workbook. Choose Personal Macro 
Workbook to make a macro available throughout Excel. The Personal Macro Workbook 
(Personal.xlsb) is a file Excel creates when you first choose to save a macro in it. (Excel 
prompts you to save Personal.xlsb when you save a macro in the Personal Macro 
Workbook and when you add macros to it after that.) Excel opens Personal.xlsb when 
you run Excel but hides the workbook by default. You can view it by choosing Unhide in 
the Window group on the View tab.

Tip  The option you choose in the Store Macro In list is retained by Excel. If you choose 
Personal Macro Workbook in this list, that option appears in the list the next time you 
open the Record Macro dialog box. Check this setting to be sure that you are saving a 
macro where you want to. 

Using the XLStart Folder

Excel by default saves Personal.xlsb in a folder named XLStart, which it creates 
under your user profile. In Windows 7 or Windows Vista, the XLStart folder is 
located at Users\username\AppData\Roaming\Microsoft\Excel. In Windows XP, 
the folder is located at \Documents and Settings\username\Application Data\
Microsoft\Excel. If you want Excel to open a specific workbook each time you run 
Excel, add that workbook to the XLStart folder. If you want each workbook you 
create to contain specific information—a custom header, for example—create 
a workbook named Book.xlsx and save it in the XLStart folder. Excel opens this 
workbook when it starts. Add the details you need to the workbook, and then save 
it with its own name.
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Before you record a macro, you should also determine whether to use absolute or 
relative cell references. (You can use a combination of the two as necessary). If you keep 
absolute references, the macro operates only in the specific cells you use when you re-
cord the macro. For example, with absolute references, if you insert a series of dates or 
names in the cell range A1:G1 as a step in recording a macro, that macro works only in 
that cell range when you run it. If you use relative references (by clicking Use Relative 
References in the Code group), the macro will insert the data in any comparable range of 
cells. 

You can alternate between absolute and relative references while recording a macro 
by turning on or off the Use Relative References command. The command appears 
highlighted when it is enabled.

Tip  The View tab also provides a Macros group. If the Developer tab is not displayed, you 
can use this group to view available macros, record a macro, and turn on or off relative 
references when recording a macro.

Macro Security Settings

The default security setting for macros in Excel is Disable All Macros With 
Notification. With this option selected, when you open a workbook that contains 
macros, Excel displays a security warning indicating that macros are disabled. Click 
Enable Macros if you trust the workbook and need access to the macros. You can 
change security settings by clicking the Macro Security command in the Code 
group on the Developer tab. Use the Macros Settings page of the Trust Center 
dialog box to select a different option. For example, if you are experimenting with 
macros during a work session, select Enable All Macros (Not Recommended) as a 
temporary measure and then reset the default option (or choose one of the other 
options that disable macros) when you are done. The other options available are 
Disable All Macros Without Notification and Disable All Macros Except Digitally 
Signed Macros.

If you select the most restrictive setting (Disable All Macros Without Notification), 
you can still gain access to macros in a workbook by saving that workbook in a 
trusted location. (The Trust Center does not check files stored in a trusted location.) 
You can view default trusted locations and add a new location by using the Trusted 
Locations page in the Trust Center dialog box (the same dialog box that Excel 
displays when you click Macro Security in the Code group).
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Digital signatures are used to verify the source of a macro and to confirm that a 
macro (or a Visual Basic project that contains a macro) has not been modified since 
it was signed. If you select the option Disable All Macros Except Digitally Signed 
Macros, Excel enables macros automatically if the macros are signed and originate 
from a source (a publisher) you have trusted. Excel displays a security warning and 
the Enable Macros button when you open a workbook from a source that is not a 
trusted publisher. Unsigned macros are disabled if you select this option.

➤ To record a macro

	 1.	 On the Developer tab, click Record Macro.

	 2.	 In the Record Macro dialog box, type a name for the macro.

	 3.	 Enter a shortcut key if you want to run the macro from the keyboard.

	 4.	 In the Store macro in list, specify whether to store this macro in the current 
workbook, the Personal Macro Workbook, or a new workbook.

	 5.	 Type a description of the macro, and then click OK.

	 6.	 To turn on relative references, click Use Relative References in the Code group.

	 7.	 Follow the steps you want to record in the macro.

Click the Use Relative References command to control the use of relative 
references as you record the macro.

	 8.	 When you complete the steps, click Stop Recording.

Modifying a Macro
When you record a macro in Excel, Excel stores the macro in a module that you can work 
with in the Visual Basic editor. To open the Visual Basic editor, click Visual Basic in the 
Code group. To work with a specific macro, first click Macros on the Developer tab (or 
click Macros, View Macros on the View tab). In the Macro dialog box, select the macro 
you want to modify and then click Edit. You’ll see the modules for the current workbook 
listed in the pane at the left (called the Project Explorer). The code for the macros in that 
module appears in the Code window.
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If you are familiar with VBA, you can modify code directly. If you are working with 
macros you recorded, you can expand and change the operations of a macro by adding 
code for one macro to another macro or by calling one macro from another.

For example, as part of recording a macro that inserts your company’s address or 
another block of text, you might apply formatting to the cells by using a specific font 
and font size, bold text, a light-colored fill, and a centered alignment. Excel would 
generate code something like the following to apply that formatting (you would see this 
code within the code that performs the macro’s other operations):

    With Selection.Font 
        .Name = "Arial" 
        .FontStyle = "Bold" 
        .Size = 11 
        .Strikethrough = False 
        .Superscript = False 
        .Subscript = False 
        .OutlineFont = False 
        .Shadow = False 
        .Underline = xlUnderlineStyleNone 
        .ThemeColor = xlThemeColorLight1 
        .TintAndShade = 0 
        .ThemeFont = xlThemeFontNone 
    End With 
    With Selection 
        .HorizontalAlignment = xlCenter 
        .VerticalAlignment = xlBottom 
        .WrapText = False 
        .Orientation = 0 
        .AddIndent = False 
        .IndentLevel = 0 
        .ShrinkToFit = False 
        .ReadingOrder = xlContext 
        .MergeCells = False 
    End With 
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    With Selection.Interior 
        .Pattern = xlSolid 
        .PatternColorIndex = xlAutomatic 
        .ThemeColor = xlThemeColorLight2 
        .TintAndShade = 0.799981688894314 
        .PatternTintAndShade = 0 
    End With

If you want to use this formatting code in another macro, you can copy the code and 
paste it into the code from another macro. You can also save this code as a separate 
subprocedure in a module and run it on its own when you want to apply the same 
formatting to a selection of cells.

A subprocedure is a set of code statements enclosed by Sub and End Sub statements. 
You can see these statements in the preceding screen shot. When you record a macro in 
Excel, the macro is defined in a subprocedure. You can call one macro from another by 
referring to the name of the macro you want to run in the subprocedure for the second 
macro. In the following code, for example, the RefreshData macro is run from the 
Auto_Open macro:

Sub Auto_Open() 
' 
' Auto_Open Macro 
' 
    MsgBox "Do you want to update financial data?", vbYesNo 
      If Response = vbYes Then 
      RefreshData 
      End If 
    
End Sub

To save code as its own subprocedure, click Visual Basic on the Developer tab. In the 
Visual Basic editor, in the Project Explorer, open the module that contains the macro with 
the code you want to copy. Select that code, and copy it to the Clipboard. 

On the Insert menu in the Visual Basic editor, click Procedure. Type a name and keep the 
default settings in the Type and Scope sections. The Sub option creates a subprocedure, 
and the Public option makes the code available to macros in other modules.

When you click OK in the Add Procedure dialog box, the Visual Basic editor inserts the 
lines Public Sub (which includes the name you provided) and End Sub. Paste the code you 
copied between these lines.

Even though you didn’t specifically record a macro with this name, you’ll find an entry 
for it in the Macro dialog box in Excel. You can now run the macro as you would any 
other, including by calling the macro from another macro. To do this, you add the 
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macro’s name to the macro you want to call it from. Here’s an example in which the 
FormatStandard macro is called at the end of the AddressBlock macro.

➤ To open the Visual Basic editor to work with a macro

➜	 Click Visual Basic in the Code group on the Developer tab.

➤ To modify a macro

	 1.	 In the Code group, click Macros.

	 2.	 In the Macro dialog box, select the macro you want to modify and then click Edit.

	 3.	 Revise the macro by using the Visual Basic editor, and then click Save on the Visual 
Basic editor toolbar.

➤ To insert a subprocedure in the Visual Basic editor

	 1.	 In Excel, click Visual Basic in the Code group on the Developer tab.

	 2.	 In the Visual Basic editor, on the Insert menu, click Procedure.

	 3.	 In the Add Procedure dialog box, type a name for the procedure.

	 4.	 In the Type group, keep Sub selected. In the Scope group, keep Public selected, 
and then click OK.

	 5.	 In the Code window, write or copy code for the new subprocedure.

	 6.	 On the Visual Basic editor toolbar, click Save.
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Run a Macro from the Macro Dialog Box
You can run a macro directly from the Macro dialog box, which Excel displays when you 
click Macros in the Code group on the Developer tab. Use the Macros In list to select 
from the macros available only in the current workbook, in all open workbooks, in 
Personal.xlsb (which contains global macros), or other choices. 

Before you open the Macro dialog box, be sure you place the cursor in the cell where the 
macro should begin its operations (if necessary). When you’ve done this, click Macros, 
select the macro you want to run, and then click Run.

When you run a macro from the Macro 
dialog box, use the Macros In list to select 
which macros you want to see.

➤ To run a macro from the Macro dialog box

	 1.	 Position your cursor where you want to start running the macro.

	 2.	 In the Code group, click Macros.

	 3.	 In the Macro dialog box, choose an option from the Macros in list to display the 
available macros.

	 4.	 Select the macro you want to run, and then click Run.

Assigning a Keystroke to a Macro
In the Record Macro dialog box, you can assign a shortcut key to a macro before you 
start recording. The shortcut key must be used in combination with the Ctrl key. You can 
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also press the Shift key to use uppercase characters or a special character you access 
with the Shift key, but you cannot use an Alt key combination. To specify this shortcut 
when you record a macro, just type the key in the Short Key area of the Record Macro 
dialog box.

If you don’t assign a shortcut key when you record a macro, you can assign one later 
through the Macro dialog box. Click Macros on the Developer tab, select the macro 
in the list of macros, and then click Options. Use the Shortcut Key area of the Macro 
Options dialog box to assign the keystroke combination you want to use.

➤ To assign a shortcut key to a macro

➜	 When you record the macro, enter the shortcut key you want to use in the 
Shortcut key area of the Record Macro dialog box.

or

	 1.	 On the Developer tab, click Macros.

	 2.	 In the Macro dialog box, select the macro you want to work with and then click 
Options.

	 3.	 In the Macro Options dialog box, enter the shortcut key in the Shortcut key area 
and then click OK.

Running a Macro When You Open a Workbook
By naming a macro Auto_Open, you define the macro so that it runs whenever you 
open a workbook. You will probably save an Auto_Open macro in a specific workbook 
(you might use an Auto_Open macro to set properties for your view of a workbook, for 
example), but you can save an Auto_Open macro in your Personal Macro Workbook 
(Personal.xlsb) so that it is applied to more than one workbook. However, keep in mind 
that an Auto_Open macro runs before other workbooks are opened, so storing it in 
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Personal.xlsb is often problematic. If you record actions that you want Excel to perform 
on the default Book.xlsx workbook or on another workbook that is opened from the 
XLStart folder, the Auto_Open macro fails when you start Excel because the macro runs 
before the workbooks stored in XLStart are opened.

See Also  For more information about the XLStart folder, see “Using the XLStart Folder” 
earlier in this chapter.

Another approach to automatically running a macro when you open a workbook is to 
use the workbook’s Open event, which you can add code to in the Visual Basic editor. 
(Events are part of Visual Basic for Applications. The default event for a command button 
is the Click event, for example. In addition to the Open event, you can control workbooks 
by using the BeforeClose or AfterClose events, for example.)

To use a workbook’s Open event, click Visual Basic in the Code group to open the Visual 
Basic editor. In the Project Explorer (the pane at the left), right-click This Workbook 
and choose View Code. In the Code window, open the list on the left (the Object list) 
and choose Workbook (if Workbook is not displayed). Open the list at the right (the 
Procedure list), and choose Open. In the Code window, you’ll see the following lines of 
code:

Private Sub Workbook_Open()

End Sub

Insert the code for the macro you want to run when Excel opens the workbook. You can 
write this code yourself, insert the name of a macro you recorded or wrote already, or 
copy code from another macro and paste it between Private Sub Workbook_Open() and 
End Sub. The code shown in the following screen shot updates an external connection to 
a text file when the workbook opens.
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See Also  For more information about working with macros in the Visual Basic editor, 
see “Modifying a Macro” earlier in this chapter. For information about managing external 
connections in Excel, see “Use External Data Sources” in Chapter 3 in this section of the 
book.

➤ To create an Auto_Open macro

	 1.	 On the Developer tab, click Record Macro.

	 2.	 In the Macro dialog box, name the macro Auto_Open.

	 3.	 Click OK, and then record the steps you want the macro to perform.

	 4.	 Click Stop Recording, and then save the workbook.

The macro runs the next time you open the workbook.

➤ To run a macro from a workbook’s Open event

	 1.	 On the Developer tab, click Visual Basic in the Code group.

	 2.	 In the Visual Basic editor, right-click This Workbook in the Project Explorer 
and choose View Code.

	 3.	 In the Code window, choose Workbook from the Object list and Open from 
the Procedure list.

	 4.	 Insert the code for the macro between the lines of code 
Private Sub Workbook_Open() and End Sub.

	 5.	 On the Visual Basic editor’s toolbar, click Save.

Adding a Macro Button to the Ribbon
To run a macro from the ribbon, you need to add the macro to a custom group. You can 
create a custom group for one of the built-in tabs or create a tab of your own and add 
the macro to a group on your custom tab.

To start, open the Excel Options dialog box from the File tab and then click Customize 
Ribbon in the list on the left. If you are adding a custom group to one of the main tabs, 
consider the purpose of the macro in deciding where to place it. If you use the macro 
to format a workbook, you might add the group to the Page Layout tab. If the macro is 
designed for working with data, it might be useful to place it on the Data tab. If you have 
several macros and want to collect them on a tab of their own, create a custom tab that 
holds all your macros.
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You can run a macro from the ribbon by adding it to a custom group on a 
built-in tab or by creating a custom tab and group to hold the macro.

If you are adding a macro to a built-in tab, use the New Group button to create a 
custom group on that tab. To create a custom tab, click New Tab. Excel creates an entry 
for the tab and creates a new group for that tab as well. To name the tab (to something 
more meaningful than New Tab), select the entry for the custom tab, click Rename, and 
then type a display name for the tab. Do the same for the new group Excel creates by 
default for a custom tab. If you are adding several macros to a custom tab, use more 
than one group and name them so that they reflect the type of macros you are adding 
(Formatting, Analysis, and so on).

In the Choose Commands From list, select Macros. In the Main Tabs list, select the group 
where you want to place the macro, select the macro in the list at the left, and then click 
Add. If you want to provide a different display name for the macro or change the icon 
Excel uses to display it, click Rename and then make the modifications you want in the 
Rename dialog box.
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➤ To add a macro to a custom tab

	 1.	 On the File tab, click Options.

	 2.	 In the Excel Options dialog box, click Customize Ribbon.

	 3.	 Under the Main Tabs list, click New Tab.

	 4.	 In the Main Tabs list, click New Tab (Custom), and then click the Rename button.

	 5.	 In the Rename dialog box, type a display name for the custom tab and click OK.

	 6.	 In the Main Tabs list, click New Group (Custom) under the tab you created, and 
then click Rename.

	 7.	 Type a display name for the group, and select a symbol if you don’t want to use the 
default icon Excel provides.

	 8.	 In the Choose commands from list, select Macros.

	 9.	 Select the macro you want to add, and then click Add.

➤ To add a macro to a built-in tab

	 1.	 On the File tab, click Options.

	 2.	 In the Excel Options dialog box, click Customize Ribbon.

	 3.	 In the Main Tabs list, select the tab where you want to add the macro and then 
click New Group.

	 4.	 In the Main Tabs list, click New Group (Custom), and then click Rename.

	 5.	 Type a display name for the group, and select a symbol if you don’t want to use the 
default icon Excel provides.

	 6.	 In the Choose commands from list, select Macros.

	 7.	 Select the macro you want to add, and then click Add.
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Adding a Macro Button to the Quick Access Toolbar
One of the most convenient ways to run a macro is to add a button for that macro to 
the Quick Access Toolbar. You assign the macro to a button by using the Excel Options 
dialog box.

On the Customize The Quick Access Toolbar page, open the Choose Commands From 
list and select Macros. In the list of macros, select the one you want to add to the Quick 
Access Toolbar and then click Add. In the Customize Quick Access Toolbar list, select 
For All Documents if you want the button to appear on the Quick Access Toolbar for 
all workbooks. You can also select the current workbook if you want to use the macro 
within that scope.

To rename the button or to change the icon associated with it, select it in the list of 
commands on the Quick Access Toolbar and then click Modify. Use the Modify Button 
dialog box to change the display name and to choose an icon. The display name appears 
in a ScreenTip when you point to the button with the mouse.

For macros you run frequently, add a button 
for that macro to the Quick Access Toolbar. 
Excel displays the name you provide in a ScreenTip.

➤ To add a custom macro button to the Quick Access Toolbar

	 1.	 Click the arrow at the right end of the Quick Access Toolbar, and then click More 
Commands.

	 2.	 In the Choose commands from list, choose Macros.

	 3.	 In the list of macros, select the macro you want to place on the Quick Access 
Toolbar and then click Add.

	 4.	 Click Modify, and then select the icon you want to use and change the display 
name for the button.

Creating an Action Macro
In a worksheet that includes graphical objects—an image, for example, or clip art or 
a shape—you can assign a macro to all or a portion of the object and run that macro 
when you click the object (or a particular spot on the object). For example, in a work-
sheet to which you’ve added several shapes (using the Shapes gallery on the Insert tab) 
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to illustrate a process or a decision path, you can assign a macro to one or more of the 
shapes. You can assign a macro to a diagram you insert using SmartArt (but not to the 
individual shapes in the diagram). You can also place an object on a picture, assign a 
macro to that object, and then apply formatting that hides the object. Using these steps, 
you effectively create a hidden hot spot on the picture that runs a macro when you 
click it. 

To run a macro from an object, right-click the object and choose Assign Macro. In the 
Assign Macro dialog box, Excel provides a default name for the macro by appending 
Click to the type of object (for example, Rectangle2_Click). Use the default name, or type 
one of your own. You can select a macro from the list of available macros (by using the 
Macros In list to display macros from your Personal Macro Workbook or from other open 
workbooks), click Record to record a new macro, or click New to open the Visual Basic 
editor and write a macro using VBA. You can also edit an existing macro by selecting it 
and clicking Edit.

In the Assign Macro dialog box, you can select 
a macro, click New to write a macro yourself, 
or click Record to record a macro you want to 
run from an object.

You’ll know that a macro is assigned to an object because the cursor appears as a hand 
with a pointing finger (the same icon you see when you point to a hyperlink). Click the 
object to run the macro.

To hide a shape or other object to which you’ve assigned a macro, right-click the shape 
and choose Format Shape. In the Format Shape dialog box, choose No Fill on the File 
page and No Line on the Line Color page.

Tip  If you are applying this formatting to a picture or another object, the Format 
command and dialog box will be named with the type of object.
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➤ To assign a macro to a shape or other object

	 1.	 Right-click the shape or object and choose Assign Macro.

	 2.	 In the Assign Macro dialog box, use the Macros in list to select the macros you 
want to see (This Workbook, All Open Workbooks, or another option).

	 3.	 Select the macro you want to assign to the shape and click OK, or click Record to 
record the macro, or click New to write the macro in the Visual Basic editor.

➤ To hide a shape or other object to which a macro is assigned

	 1.	 Right-click the shape and choose Format Shape.

	 2.	 In the Format Shape dialog box, on the Fill page, click No Fill.

	 3.	 On the Line Color page, click No Line.

Practice Tasks

The practice files for these tasks are located in the folder for Microsoft Excel 2010. 
You can save the results of these exercises in the same folder. Change the file name 
so that you don’t overwrite the sample files. When you are done, try performing 
the following tasks:

●	 Open a blank worksheet. Record a macro named GetResults that performs 
the following operations:

❍	 Uses the From Text command in the Get External Data group (on the 
Data tab) to import the text file Results.txt (which is included in the 
sample files folder). Click Next in the Text Import Wizard’s first step. In 
the second step, select comma as the delimiting character and then click 
Finish.

❍	 Select the top row of the data, and apply bold formatting.

❍	 Select the cells containing the data, and format them as currency.

❍	 Stop recording the macro at this point. Delete the data you imported, 
and then run the macro from the Macro dialog box to test it.

●	 Open the workbook SampleMacros.xlsm. Using the macros in this workbook, 
practice running the macros from the ribbon, from the Quick Access Toolbar, 
and from an object you add to the workbook.



290    Exam 77-888  Microsoft Excel 2010 Expert

4.2  Insert and Manipulate Form Controls
One way in which you can collect and present data in Excel is through the use of form 
controls you add to a worksheet. Controls such as list boxes, check boxes, and command 
buttons help structure a worksheet and manage its data, and they allow you and other 
users to work with data and objects on a worksheet in specific ways. The sections that 
follow describe how to add controls, define their behavior and values, and set properties 
for the controls.

Inserting Form Controls
Excel displays two groups of controls when you click Insert in the Controls group on the 
Developer tab—form controls and ActiveX controls. You can set up a form control, such 
as a list box, by using data on a worksheet. ActiveX controls are often handled program-
matically by using Visual Basic for Applications, although you can set properties for 
ActiveX controls and use them without writing any code. The focus in this section is on 
form controls. You’ll learn more about ActiveX controls in the section “Making Use of 
ActiveX Controls” later in this chapter.

Excel provides nine types of form controls:

●	 Command button  Use a command button to run a macro when a user clicks the 
button. 

●	 Combo box  A combo box creates a drop-down list that lets users select an item 
from a set of items you define or enter an item in the list.

●	 Check box  Use a check box to let users make selections from a series of options. 
A user selects the check box to indicate yes (or true). A user clears a check box to 
indicate no (or false). You can place a set of check boxes in a group box to present 
them as a single element. Users can select more than one check box in a group to 
indicate a range of choices. (For example, on an order form, users could select each 
of the product categories they want to review.)

●	 Spin button  Add a spin button to increase or decrease the value (within a 
minimum and maximum value that you define) in a specific cell. When you click the 
up or down arrow on the spin button, the value in the cell that the button is linked 
to changes, and you can see how these changes affect the results of formulas, for 
example. 

●	 List box  Use a list box to display a set of items from which users can choose (a 
set of nine colors, for example). You can define a list box so that users can select 
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only a single item, multiple items that are adjacent, or multiple items that are not 
adjacent.

●	 Option button  An option button marks one in a set of exclusive options. For 
example, Update Manually or Update Automatically. As you do with check boxes, 
you often present option buttons within a group box.

●	 Group box  A group box organizes a set of controls into a single element. You 
usually use a group box with check boxes or option buttons.

●	 Label  Use a label to identify or describe the function of a cell, cell range, or 
another control. You can use a label as you would a caption.

●	 Scroll bar  The scroll bar control is similar to the spin button. As you change the 
position of the scroll bar, you change a value in the cell the scroll bar is linked to.

To add any of these controls to a worksheet, click Insert in the Controls group, click the 
icon for the type of control you want to add (ScreenTips identify each control), and then 
click the cell on the worksheet where you want to place the control. Your next step is 
usually to right-click the control and choose Format Control. You use the Format Control 
dialog box to specify a cell range for a list, for example, or to specify whether a check 
box is selected by default, or to set up the maximum and minimum values for a spin but-
ton or a scroll bar. In the sections that follow, you’ll learn more details about setting up 
each type of control.

Important  The text field, combo list edit control, and combo drop-down edit controls 
do not apply in Excel 2010, nor does the Run Dialog button. These controls are used in 
Excel 5.0 dialog sheets. 

Inserting a Command Button
Form control command buttons are designed to run macros. When you add a command 
button to a worksheet, Excel displays the Assign Macro dialog box and assigns a default 
name to the macro it will associate with the button. To assign a macro that you already 
recorded or developed in VBA, use the Macros In list to specify the list of macros you 
want to choose from (All Open Workbooks or Personal.xslb, for example). Then select 
the macro and click OK. (If you want to make changes to a macro after you select it, click 
Edit.) 

To work with a new macro, click New to write the macro in the Visual Basic editor or click 
Record to open the Record Macro dialog box, where you can name and describe the 
macro and then record it.
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Excel opens the Assign Macro dialog box 
when you add a command button form 
control to a worksheet.

To change the label on a command button, click Design Mode in the Controls group, 
right-click the control, and choose Edit Text. The cursor is positioned at the start of the 
default text (something like Button 1). Select that text, delete it, and then type a label 
that describes the button’s operation.

Setting Up a Combo Box or a List Box
You define the items that appear in a combo box or list box control by entering them in 
a cell range. You can list the items on the same worksheet or on a different worksheet in 
the workbook. (The source of the items can come from a cell range in a separate work-
book, but that workbook must be open to populate the list in the control.)

Click the combo box icon in the group of form controls, and then drag across the 
worksheet to position the combo box and set its initial size. You can resize the control by 
dragging one of the handles on its borders and at the corners. To reposition the control, 
point to the border (you’ll see the cursor appear as a four-way arrow) and then drag it to 
a new location. 

Right-click the control and choose Format Control to open the dialog box in which you 
specify properties for the control. On the Control tab of the Format Control dialog box, 
click in the Input Range box and then specify the cell range for the list. You can type the 
range or drag through it on the worksheet where the list appears.

In the Cell Link box, specify a cell (or a cell range) in which you want to capture 
the value that reflects which item a user selects in the list. The items are numbered 
sequentially. You might use this value in a formula, for example, or to control other 
aspects of the form.
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For a combo box and a list box 
control, you specify the input range 
for the list and the linked cell that 
shows which option is selected in 
the control. For a list box, you also 
specify a selection type.

You follow the same steps for defining an input range and a linked cell for a list box. On 
the Controls tab for a list box, you also need to specify an option in the Selection Type 
area. The options in this area are Single, Multi, and Extended. Use Single if you want 
a user to select only one item from the list. The Multi option enables users to select 
multiple adjacent items, and Extended lets users select items that are not adjacent.

See Also  You can learn more about the options on the other tabs of the Format Controls 
dialog box in the section “Defining Form Control Properties” later in this chapter.

Inserting Check Boxes and Option Buttons
After you insert a check box or an option button control (or a set of these controls), 
right-click the control and choose Format Control. On the Controls tab for these controls, 
use the Value area to specify whether the control should be selected or deselected as its 
default state. A Mixed value applies to multiple selections. Also specify the linked cell. 
When a check box is selected, the linked cell displays the value True. You can use this 
condition to affect the results of formulas. For example, you could refer to the linked cell 
in an IF statement that inserts a value in the cell with the IF formula depending on the 
state of the check box.
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When you add a set of options buttons to a group control, right-click one of the option 
buttons and then specify the linked cell in the Cell Link box on the Control tab. You need 
to set the linked cell only once. Each option button enclosed in the group control uses 
the same linked cell.

To change the label for a check box, option button, or group control, right-click the 
control (be sure you have Design Mode enabled) and choose Edit Text. The cursor 
appears at the start of the default text. Select that text, delete it, and then type a label 
that identifies the control.

Using Spin Buttons and Scroll Bars
Add a spin button or a scroll bar to a worksheet when you need a control with which 
you can increase or decrease the value (within a range that you define) in a specific 
cell. On the Control tab for a spin button, you specify the current value (which you 
can leave blank or at the default value 0), the minimum and maximum value, and the 
interval for incremental changes. You might specify a range of 1,000 to 10,000 with 
incremental changes of 500, for example. You also need to specify the cell (in the Cell 
Link box) where the value set by the control appears. Here again, you can use this value 
in calculations as you need to. For example, if the value in the linked cell equals or 
exceeds a certain amount, you can use an IF statement to set the value in another cell 
accordingly.
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Tip  If you want to use a spin button to change a cell’s value as a percentage instead of 
as a set increment, enter a formula in another cell that divides the value in the linked cell 
by 100.

A scroll bar control also adjusts the value in a cell as you move the scroll bar up or down. 
You can use a scroll bar to continuously change the value of the linked cell as you scroll. 
On the Controls tab, set the values for the current value, the minimum and maximum 
values, and the value for incremental change. The Page Change field affects the speed at 
which the scroll bar changes values. Scroll up to move toward the minimum value; scroll 
down to move incrementally toward the maximum value for the control.

Spin buttons and scroll bars change 
the value in the linked cell when you 
interact with the control. Specify the 
maximum and minimum values you 
want to use.

Adding a Label
Use a label control to identify controls (or other items on a worksheet) that don’t have 
labels of their own. You probably won’t add a label for a command button or a check 
box, for example, but you might use a label for a combo box or a list box. To enter the 
text for a label, right-click the control and choose Edit Text.
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Creating a Data Form

Excel can create a data form from the column headings in a table or a cell range. A 
data form is especially useful for entering and updating information in a worksheet 
in which you frequently scroll to enter data in many columns. A data form presents 
the columns in a single dialog box that also includes command buttons that let you 
delete a row or add a new row.

The first step in creating a data form is to add the Forms button to the Quick 
Access Toolbar. Click the arrow at the right end of the Quick Access Toolbar, click 
More Commands, and then choose All Commands from the Choose Commands 
From list. Scroll down to the Forms button, select it, click Add, and then click OK. 
Open the workbook in which you want to create a data form (which should be 
organized with column headings, of course), and then click the Forms button. 
Excel creates the dialog box, which you can then use to work with the data in the 
workbook.

➤ To insert a command button

	 1.	 On the Developer tab, click Insert in the Controls group.

	 2.	 In the Form Controls group, click the command button icon, and then click on the 
worksheet where you want to place the button.

Excel displays the Assign Macro dialog box.
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	 3.	 In the dialog box, type a name for the button’s macro (or use the default name 
Excel provides.)

	 4.	 Select the macro you want the button to run, or click New to write a macro in the 
Visual Basic editor, or click Record to record a new macro.

➤ To insert a combo box or list box control

	 1.	 On the Developer tab, click Insert in the Controls group.

	 2.	 In the Form Controls group, click the combo box or list box icon, and then click on 
the worksheet where you want to place the control.

	 3.	 Right-click the control and choose Format Control.

	 4.	 On the Control tab of the Format Control dialog box, specify the input range and 
the linked cell for the control.

	 5.	 For a list box, choose the selection type (Single, Multi, or Extended).

➤ To insert a check box or option button control

	 1.	 On the Developer tab, click Insert in the Controls group.

	 2.	 In the Form Controls group, click the check box or option button icon, and then 
click on the worksheet where you want to place the control.

	 3.	 Right-click the control and choose Format Control.

	 4.	 On the Control tab of the Format Control dialog box, use the Value area to specify 
whether the control should be selected or deselected by default.

	 5.	 In the Cell link box, specify the cell that you want to link to the control.

	 6.	 To create a group of check boxes or option buttons, click Insert in the Controls 
group, click the group box icon, and then click on the worksheet where you want to 
add the group.

	 7.	 Drag the check box or option button controls into the group control.

➤ To insert a spin button or scroll bar control

	 1.	 On the Developer tab, click Insert in the Controls group.

	 2.	 In the Form Controls group, click the spin button or scroll bar icon, and then click 
on the worksheet where you want to place the control.

	 3.	 Right-click the control and choose Format Control.
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	 4.	 On the Control tab of the Format Control dialog box, enter values in the Current 
value, Minimum value, Maximum value, and Incremental change boxes. For a 
scroll bar, also enter a value for the Page change box.

	 5.	 In the Cell link box, specify the cell that you want to link to the control.

➤ To insert a label control

	 1.	 On the Developer tab, click Insert in the Controls group.

	 2.	 In the Form Controls group, click the label icon, and then click on the worksheet 
where you want to place the control.

	 3.	 Right-click the control and choose Edit Text.

	 4.	 Delete the default text, and then type the text you want to use.

➤ To change the default label for a command button, option button, or 
check box

	 1.	 Right-click the control and choose Edit Text.

	 2.	 Delete the default text, and then type the text you want to use.

Defining Form Control Properties
The Format Controls dialog box contains several other tabs that you work with to 
manage the size, display, and behavior of form controls:

●	 Size tab  On the Size tab, you can adjust the height and width of controls (and the 
proportional scale). Use the Lock Aspect Ratio option to keep the height and width 
of the control proportionate.

●	 Protection tab  The Protection tab lets you lock a control (and the text contained 
in some controls), but as information on the Protection tab explains, the options 
you set on this tab “have no effect unless the sheet is protected.” To protect the 
worksheet, click Protect Sheet on the Review tab, or click Format on the Home tab 
and choose Protect Sheet.

See Also  For more information about applying protection to a worksheet, see 
“Protecting Worksheets and Workbooks” in Chapter 1 in this section of the book.

●	 Properties tab  Options on the Properties tab affect the positioning of a control 
and whether the control appears when you print the worksheet. The positioning 
options are Move And Size With Cells, Move But Don’t Size With Cells, and Don’t 
Move Or Size With Cells. These settings affect the behavior of the control when you 
resize or move cells that appear behind them. 
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The default settings for the options on the Properties tab depend on the type 
of control. For example, the Print Object option is not selected for a command 
button, but this option is set by default for a check box. The Move And Size With 
Cells option is enabled for a command button, but this option is not available for 
many other types of controls.

●	 Alt Text tab  The Alt Text tab lets you provide text that is displayed while a form is 
loading in a web browser. Alt text is also used in search engines and can provide 
people with disabilities with information about a control.

Some types of controls include other tabs. For example, the Format Control dialog box 
for check boxes and option buttons includes the Colors And Lines tab. Use this tab to 
specify a fill color and degree of transparency, as well as a line color, style, and weight. 
(The options for arrow styles are not available.)

You can apply additional formatting to a command button control by using the Font, 
Alignment, and Margins tabs in the Format Control dialog box. The settings on the 
Margins tab affect the positioning of the button’s label.

For a command button control, use 
the Font and Alignment tabs to modify 
how the button is displayed.

➤ To set properties for form controls

	 1.	 Right-click the control and choose Format Control.

	 2.	 Use the Size, Protection, Properties, and Alt Text tabs in the Format Control 
dialog box to specify options for the control’s behavior.
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	 3.	 For a command button control, use the Font, Alignment, and Margins tabs to 
apply additional formatting to the button and its label.

	 4.	 For check boxes and option button controls, use the Colors and Lines tab to apply 
line styles and fill colors.

Making Use of ActiveX Controls
The types of basic ActiveX controls you can insert on a worksheet form are similar to 
the types of form controls. You can insert a command button, a combo box, a list box, a 
check box—all the same types of controls except for a group box. You can also insert an 
ActiveX text box control, an image control, and a toggle button control.

●	 In a text box, you can type, edit, or display data that is linked to a cell. 

●	 Use a toggle button control to signify Yes/No or On/Off. A toggle button changes 
its appearance when it is enabled and when it is not. 

●	 Use an image control to embed an image on a form.

When you click More Controls in the ActiveX Controls group, Excel displays a dialog box 
that lists numerous ActiveX controls that are installed with Excel. These are generally 
advanced controls that require programming. 

To insert an ActiveX control, click the icon for the control in the ActiveX Controls group 
(click Insert in the Controls group to display the menu of controls), and then click the 
spot where you want to place the control on the worksheet. The steps you take at this 
point depend on the type of control you are inserting.

When you add an ActiveX command button control, for example, you won’t see the 
Assign Macro dialog box. To provide the code you want the button to execute, right-click 
the button and choose View Code to open the Visual Basic editor. In the Code window, 
you will see the opening and closing lines of a subprocedure for the button’s Click event. 
If you aren’t familiar with VBA, you can enter the name of a macro you recorded here or 
copy and paste the code for a macro you recorded.

You can set properties for a command button (such as BackColor, Locked, Height, Width, 
and others) and for other controls by clicking Design Mode, right-clicking the button, 
and then choosing Properties. (You can also click Properties in the Controls group.) The 
Properties pane that’s displayed lets you view a control’s properties alphabetically or by 
category.
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One advantage of using ActiveX controls is the extensive
list of properties you can use to affect how the control is 
displayed and behaves.

Some properties are the same as for form controls. For example, ActiveX controls have a 
LinkedCell property that serves the same purpose as the Linked Cell box on the Format 
Control dialog box you use with form controls. The Placement property is comparable 
to the options that control moving and sizing a control that you can select on the 
Properties tab of the Format Controls dialog box.

You can use the Font property for an ActiveX list box control, for example, to change 
the font and font formatting applied to the list items. Other properties you can set for a 
list box include BorderColor, BorderStyle, TextAlign, and Visible (which lets you hide the 
control if you want to). Other types of controls have the same or similar properties.

Two important properties to keep in mind are the Name property and the Caption 
property. The Name property identifies the control (such as CommandButton1). The 
Caption property, which does not apply to all control types, sets the text displayed in a 
control. For a check box or a command button, for example, type the text you want the 
control to display in the Caption property. 

Here are some of the other important properties you work with in setting up different 
types of ActiveX controls:

●	 Check box  Set the Value property to True to select the check box; set this property 
to False if you want the check box to be cleared. Among the formatting properties 
for a check box are BackColor, Shadow, SpecialEffect, and TextAlign.
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●	 Combo box  Use the ListFillRange property to specify the cell range that includes 
the items you want the combo box to display. (You need to type the cell range 
here; you can’t drag through the worksheet as you can for a form control.) To set 
up a two-column combo box, specify 2 for the ColumnCount property, set the 
ColumnHeads property to True, and set the ColumnWidths property so that each 
column is displayed at the size you want it. The BoundColumn property controls 
which column (in a multicolumn combo box) provides a value. The ListRows 
property sets the maximum number of rows to display.

●	 List box  As you do for a combo box, use the ListFillRange property to specify 
the input range. The MultiSelect property controls whether users can select 
one or more items in the list box. Use fmMultiSelectSingle for selecting a single 
item. Use fmMultiSelectMulti to allow selection of multiple adjacent items. The 
fmMultiSelectExtended option is the value to choose if you want users to be able 
to select multiple nonadjacent items.

●	 Option button  Set the Value property to True or False to specify whether the 
option button is selected by default.

●	 Scroll bar  Use the Max and Min properties to set the range of values controlled by 
the scroll bar. The SmallChange property specifies the increment in which the value 
changes when you click the up or down arrow. The LargeChange property speci-
fies the increment of change when you click the area of the scroll bar between the 
arrows.

●	 Spin button  Use the Max, Min, and SmallChange properties to specify the 
maximum value, minimum value, and increment of change. Here, as with other 
controls, the LinkedCell property specifies the cell in which the value associated 
with the spin button appears.

Security Settings for ActiveX Controls

As it does for macros, the Trust Center provides a page in which you can review 
and change security settings for ActiveX controls. With the default setting, Excel 
notifies you that a workbook contains active content. You need to click Enable 
Content in the message bar to let ActiveX controls run. You can also choose an 
option to disable all ActiveX controls or to enable all controls without restrictions 
(this option is not recommended because some ActiveX controls could run code 
that harms your computer). Or you can choose an option to be prompted to enable 
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controls that are marked by a developer as Safe for Initialization (SFI). If a control is 
not marked, it is not considered safe (making it a UFI—Unsafe for Initialization—
control) and is not enabled.

To change these settings, click Options on the File menu. In the Excel Options 
dialog box, click Trust Center. Click Trust Center Settings, and then click the ActiveX 
Settings page.

➤ To insert and set properties for an ActiveX control

	 1.	 On the Developer tab, click Insert in the Controls group.

	 2.	 In the ActiveX Controls group, click the icon for the control you want to add, and 
then click on the worksheet where you want to place the control.

	 3.	 In the Controls group, click Design Mode.

	 4.	 Right-click the control, and then click Properties.

	 5.	 Use the properties pane to specify values for the control’s properties.

Tip  For a summary of ActiveX control properties, see the previous section. See the 
Excel help topics under Forms and Controls for extensive lists of properties you set for 
specific ActiveX controls.

A Simple Order Form
Combining form controls and ActiveX controls with formulas and functions is what 
makes forms most useful. For example, here are some steps you could follow to create 
a simple order form that uses several combo boxes, matching spin buttons, a group of 
option buttons, and a command button (all form controls), together with the INDEX, IF, 
and SUM functions. 
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	 1.	 Add four combo boxes (or some appropriate number of them) to a worksheet. 
Stack the combo boxes in the same column. You can size them so that they fit in 
a single row. The input range for these combo boxes will be the same and refer to 
the cell range where you list your products. (In this example, the list is included in 
a cell range on a separate worksheet.) Set the Cell Link box in the Format Controls 
dialog box to point to the cell adjacent to the combo box in the next column 
(column C here, the product ID).

	 2.	 Add matching spin buttons with which users can specify a quantity. Set the 
minimum and maximum range and the incremental change to appropriate values 
(1 to 25 with an increment of 1). Set the Cell Link box for each spin button to the 
cell adjacent to the control (column E in this example).

	 3.	 In the sample order form, prices for each product are listed on a separate 
worksheet next to the corresponding product. Products are identified in the linked 
cell for the combo box by the number of their order in the list. By using the INDEX 
function and a reference to the linked cell, the product price is entered in column 
G. The full formula (for row 5) is =(INDEX(Sheet2!B1:B10,C5)). The first argument for 
the INDEX is the cell range with the prices. The second argument (C5) is the linked 
cell for the combo box. When a user selects a different product from the combo 
box, the value in cell C5 (or cells C7, C9, and C11) changes and the INDEX function 
returns the price for that product. 

	 4.	 The value for each entry in the Total column is calculated by multiplying the 
quantity (column E) with the price in column G. The total in cell I13 is just the sum 
of the item totals.
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	 5.	 The shipping amount is also determined by the INDEX function in conjunction with 
the group of option buttons that identify shipping options. The amount charged 
for each option is listed on a separate worksheet. The linked cell for the option 
button group is F14. When a user selects a shipping option, the value in the linked 
cell reflects that choice. The formula in cell I14 uses the INDEX function to look up 
shipping charges: =(INDEX(Sheet2!E1:E3,F14)).

	 6.	 An IF statement in cell I16 determines whether the order is large enough to receive 
a 10 percent discount. The formula is =IF(I13>=100,I13*-.1,0). If the value of the 
order (in cell I13) is greater than or equal to 100, a discount of 10 percent of that 
amount is entered in cell I16. If the order is less than 100, the formula enters 0 and 
the value is displayed as ‘-’.

	 7.	 To finish off the order form, the command button runs a macro that saves the form 
as a PDF file.

Practice Tasks

The practice files for these tasks are located in the folder for Microsoft Excel 2010. 
You can save the results of these exercises in the same folder. Change the file name 
so that you don’t overwrite the sample files. When you are done, try performing 
the following tasks:

●	 Open the file LoanCalculator.xlsx. Sheet1 identifies the cells whose input is 
required for the PMT function, which you can use to calculate loan payments 
based on interest rate, loan amount, and number of payments.

●	 Insert form controls to automate the formula by using the named cells as 
the linked cells for various controls. Add a spin button control that changes 
the interest rate between 3 and 9 percent. (You need to divide the value by 
100 to insert a percentage in the formula.) Add a scroll bar that changes the 
amount of a loan between $5,000 and $30,000 in $1,000 increments. 

●	 Create a list for the possible number of payments (12 through 60). In the 
adjoining column, number these options 1 through 5. Add a list box control 
to your form, and use the cell range that contains the list of payment options 
as the input range. Specify the Number of Payments cell as the linked cell. 

●	 Now use the LOOKUP function to equate the output from the list box with 
the number of payments. The syntax for the LOOKUP function is =LOOKUP 
(lookup_value,lookup_vector,[result_vector]). Here, you look up the value in the 
Number of Payments cell, compare it to the numbered list 1–5, and return the 
matching result from the list of payment options to the PMT formula. 
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Objective Review
Before finishing this chapter, be sure you have mastered the following skills:

4.1	 Create and manipulate macros
4.2	 Insert and manipulate form controls
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Index

Symbols
# symbol, 366
? wildcard character, 366

A
absolute cell references, in macros, 276
absolute values, calculating, 51
.accde file name extension, 318–319
Accept menu, 81
Accept Or Reject Changes dialog box, 181–182
access

restricting (Word), 15–17
to workbooks, 161

Access deployment files (.accdc), 317
Access Options dialog box, 326–331

Add-Ins page, 329
Current Database category, 327–328
Datasheet category, 328
General tab, 326
Language page, 328
Object Designers category, 328
Proofing page, 328
Trust Center page, 329–330

Access Services, 635
publishing databases to, 315, 321–322

Access 2010. See also databases; database records; 
database tables

application parts, adding, 339–346
Backstage view, 309–330
built-in forms, 340
calculated fields, generating, 461–465
compatibility issues, 316
data connections with Excel, 262–263
data macros, creating, 357–359
databases, creating and managing, 309–330
databases, publishing to SharePoint sites, 637–638
Datasheet view, 347. See also Datasheet view (Access)
Design view, 347–359. See also Design view (Access)
expressions, 353
fields, creating and modifying, 360–369
file format, 316
form design options, applying, 408–421
forms, arranging fields and objects on, 422–426
forms, creating, 396–407
forms, formatting, 426–434
Home tab, 370–371
importing data into, 384–393

Live Preview, 489
navigation pane, configuring, 331–339
Open dialog box, 313–314
options, setting, 326–330
queries, constructing, 435–451
query fields, manipulating, 454–457
records, sorting and filtering, 370–377
Report Arrange tab options, applying, 483
Report Design tab options, applying, 475–482
Report Format tab options, applying, 486–488
Report Page Setup tab options, applying, 488–491
reports, creating, 468–474
Save & Publish command, 315–323
Save Object As command, 313, 320–321
source tables and relationships, managing, 451–454
table relationships, setting, 378–383
tables, creating in Design View, 347–359

Accessibility Checker, 177–179
action macros, creating, 287–289
ActiveX command button controls, 300
ActiveX controls, 300–303

adding to forms, 144–145
Caption property, 301
command buttons, 138–141
configuration settings for (Word), 7
inserting, 300
Name property, 301
order form, creating with, 303–305
properties, setting, 300–301
security settings, 302–303

ActiveX image controls, 300
ActiveX text box controls, 300
ActiveX toggle button controls, 300
Add Existing Fields command (Access), 401, 417–422
Add Gallery To Quick Access Toolbar command 

(Access), 409
Add Help Text button, 157
add-ins

configuration settings for (Word), 7
in databases, managing, 329
installing, 8
managing (Word), 6
managing, 329 (Access)
unloading, 8

Address Block command (Word), 107
address blocks

inserting, 109
modifying, 107–108

address lists
creating, 105–107
fields, customizing, 107

addresses, mailing, validating, 119
Add Scenario dialog box (Excel), 231
Add To Quick Style List option, 43
Add Trendline dialog box (Excel), 213
Add Users dialog box (Word), 14
Advanced Filter/Sort window (Access), 372, 375
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Advanced Search page (SharePoint), 627–629
Language section, 627
Property Restrictions section, 627
Result Type area, 627

advanced searches, 627–629
for people, 631–632

alerts
for colleagues’ profile changes, 584–585
search alerts, 624–625
in SharePoint, 555–556

All Site Content page (SharePoint), 503–506
accessing, 504
default page, 505
document libraries, displaying, 506
elements on, 505
repositories on, filtering, 506

Allow Additions property, 419
Allow Datasheet View property, 418
Allow Deletions property, 419
Allow Edits property, 419
Allow Filters property, 419
Allow Form View property, 418
Allow Layout View property, 418
Allow Users To Edit Ranges dialog box (Excel), 172
Allow Zero Length field property, 366
Analysis ToolPak (Excel), 237–244

Anova (variance) analysis, 243
correlations, calculating, 243
covariance, calculating, 243
Descriptive Statistics option, 237–238
histograms, displaying, 238–239
loading, 237, 243
moving averages, calculating, 243
percentiles, determining, 240
random number generation, 240–242
rank order, determining, 240
sampling options, 242

AND() function, 51
annotating documents, 74–75
announcements lists, creating, 509
Anova (variance) analysis, 243
Answer reports, 235
Append Only property, 367
append queries, 443–444
appending data, 389–390
application parts

adding, 339–346
blank forms, 339–342
Quick Start application parts, 342–344
user templates, 344–346

approval workflows, 532
creating, 533–534

archiving records, 443–444
arguments

defined, 52
evaluating, 51, 53
for Excel functions, 207
false, 52
positional arguments, 53

array arguments, 202

array constants
creating, 205
defining, 203–204
in formulas, 205
naming, 205

array formulas, 201–205
entering, 202
restrictions on, 202–203

array ranges, 202
Ask rules, 110–111
Assign Macro dialog box (Excel), 288
asterisk (*), 366
attachment controls, 414
Attachment data type, 350
auditing formulas (Excel), 185–195
Auto Check For Errors command (Word), 112
AutoCaptions, 89
AutoClose macros, 138
AutoCorrect dialog box (Word), 11–12
AutoCorrect options for databases, 332
AutoCorrect Options button (Word), 11
AutoExec macros, 138
AutoExit macros, 138
autoformatting, 11
AutoMark files, 95, 97, 100
Automatically Update Document styles option, 22
automating tasks. See macros
AutoNew macros, 137–138
AutoNumber data type, 349
Auto_Open macros, 282

creating, 284
AutoOpen macros, 137–138
AutoRecover, setting file location for, 5
AutoText entries

creating and inserting, 62–64
saving, 64

AVERAGEIF function, 200
AVERAGEIFS function, 201
averages, calculating, 51

B
background images

for forms, 427–428
for reports, 486

backgrounds, for forms, 427–428
Backstage view (Access), 309–330

commands in, 309
My Templates, 19
opening, 309, 310

Bernoulli distribution models, 241
best bets, 620–623

associating existing best bets with, 622
creating, 622–623
modifying, 623

bibliographies
creating, 86–87
saving to gallery, 87

Bibliography gallery, 87

Advanced Search page (SharePoint)



	     667

bin ranges, 204
Binomial distributions, 241
blank forms

adding to databases, 339–342
built-in types, 340
creating, 398–401
viewing, 340–341

Blank Report command (Access), 468, 470
Block Authors command (Word), 15
bold, keyboard shortcut for, 33
boldface elements in book, v
book conventions, v
Bookmark dialog box (Word), 96
bookmarks

associating values with, 112
in documents, 70
index page ranges, 96, 100

Book.xlsx files, 275
Boolean searches, 619–620
bound controls, 411
bound object frame controls, 415
breadcrumb trail, 499, 506–509
browser controls, 413
browsers. See web browsers
budget templates, designing, 162
building block content controls, 25, 29
building blocks, 144

adding to documents, 60
adding to forms, 146
bibliographies, 86
customizing, 60–68
description, 61
global template settings for, 21, 24
saving in template, 61

Building Blocks Organizer, 60
business intelligence, 635
business intelligence sites, 658
button controls, 412
buttons. See also command buttons

macros, assigning to, 131
option buttons, 293–294

C
Calculated data type, 350
calculated fields

generating, 461–465
renaming, 461

Calculate Now command (Excel), 196–197
Calculate Sheet command (Excel), 196–197
Calendar lists, creating from meeting workspaces, 577, 

580
Caption dialog box (Word), 88
Caption field property, 365, 368
Caption Numbering dialog box (Word), 89
captions, for document elements, 88–89
cell ranges, user operations on, 172
cell references, 53

absolute or relative, in macros, 276

cells
averaging values in, 200–201
counting, 200
data validation rules for, 187–190
error values in, 192–193
merging and splitting, 484
naming, 225
precedents and dependents in, 185–187
repositioning, 484
set cells, 226
values in, increasing and decreasing, 294–295
watching, 193

Change Chart Type dialog box (Excel), 216, 223
Change group, sharing options, 179
change history settings, 182
Change permission, 173

setting, 16
change tracking. See tracking changes
Changes group, 81
character formatting (Word), 33–41

applying, 40
character spacing, 37

Character Map, 39
character styles, creating and applying, 44–45
chart controls, 414
Chart Tools Design tab (Excel) Type group, 216
Chart Tools Layout tab (Excel), 213

Analysis group, 214
Chart Tools tabs (Word), 55
Chart Web Part, configuring, 662
charts (Excel)

advanced features, 211–224
drop lines, 214
dual-axes charts, 222–224
high-low lines, 214
secondary axes, adding, 223–224
sparklines, 217–222
templates for, 216–217
trendlines, adding, 212–216
up-down bars, 214

charts (Word)
axes, 56
background areas, 56
chart type, changing, 55
creating and editing, 54–58
data, editing, 58
data source, 55, 57
formatting elements of, 56, 58
inserting, 57
layouts and styles, 55, 58
saving as template, 56, 58

check box controls, 26, 29, 144, 290, 414
adding to forms, 146
inserting, 293–294, 297
properties, setting, 301

check box form fields, 156
Check Grammar With Spelling option, 10
Circle Invalid Data command (Excel), 189
circular references, 197

circular references
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citations, 82
adding to documents, 83–85
built-in styles, 83
editing, 84
inserting, 84
marking, 91–92, 94
placeholders for, 83, 85
sources, managing, 85–86

Citations & Bibliography group, 83
Clear Grid command (Access), 375
Client Forms command (Access), 406
Close Button property, 419
code

copying and pasting in macros, 279
saving as subprocedure, 279

collaborative SharePoint sites, 583. See 
also SharePoint sites

Colleague Tracker Web Part, configuring, 584–585, 
587–588

colleagues, 583
adding to My Site, 584, 586–587
adding people as, 630
status changes of, 587

Collect Feedback workflow, 532
Collect Signatures workflow, 532
color schemes, defining or modifying, 409, 428
columns

adding to content types, 571
indexing, 610–611
properties, 520
in SharePoint repositories, creating, 516–519

Combine Revisions From Multiple Authors Into A 
Single Document command (Word), 78

combined documents
creating, 78–80
reviewing, 80–81

combining documents, 78–80
combo box controls, 25, 28, 144, 290, 413

adding to forms, 146
building lists in, 148
properties, setting, 302
setting up, 292–293, 297

combo box lookup fields, 351
Combo Box Wizard (Access), 415
Command Button Wizard (Access), 415
command buttons, 290

ActiveX controls, 300
inserting, 291–292, 296
macros, running from, 138–141
properties, 299

commands, ribbon, vii
comments

adding to document, 74–75
initials in, 4
note content commenting, 583
replying to, 74
size and position of, 76
viewing, 75

Compact & Repair Database command (Access), 
323–324

Compact Database Into dialog box (Access), 324

Compare And Merge Workbooks command (Excel), 
adding to Quick Access bar, 182

Compare Documents dialog box (Word), 78–79
comparing versions of documents, 78–80
Compatibility Checker (Excel), 178–179
composite keys, 378
conditional formatting

data bars, using, 432–433
for forms, 430–434
for reports, 487–488
values or expressions, using, 431–433

Conditional Formatting Rules Manager dialog box 
(Access), 430–431

confidential information, hiding from search, 610, 
612–613

Confirm Data Source dialog box (Word), 116
Connection Properties dialog box (Excel), 262

Definition tab, 262
connections to data sources, creating, 261–268
contacts database, publishing to SharePoint site, 637
contacts list (Outlook)

details in, 117–118
refreshing, 118
synchronizing SharePoint list with Outlook, 646–647

content
access to, managing, 572–576
enabling, 135–136
excluding from indexing, 612
formatting, 33–72
hiding from search, 610
managing, 568
reusable content, 59–68
searching for, 614–617
searching SharePoint sites for, 608–614
tags and notes, adding to, 601–606
updates to, synchronizing, 649
uploading to SharePoint, 568

Content And Structure page (SharePoint), 551–552
Content Control Cannot Be Deleted option, 147
Content Control Properties dialog box (Word), 147, 

148
content controls

adding to forms, 143–145
adding to templates, 24–27, 28
aligning, 143
formatting, 148, 149
grouping, 26, 145
help text, adding, 150–151
lists, building, 148, 150
locking, 149
properties, setting, 29, 147–150
protecting, 26
tags for, 153
text, editing, 146, 150–151
text in, changing, 26–27, 29
title of, 147
XML elements, assigning to, 151–154

Content Organizer (SharePoint), 553–555
enabling, 554
settings, 554

citations
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content types
assigning management of, 569–570
columns, adding to, 571–572
document set content type, 541–542
for documents sets, 539
vs. file types, 568
managing, 568–572
Phone Call Memo, 571
repositories, assigning to, 570–571
Task content type, 569
workflow on, controlling, 568
workflows associated with, 532

Contents Cannot Be Edited option, 144
contextual spelling, 9
Control Panel, Fonts, 39
Control Source property, 411, 414
control wizards, 415
controls. See also content controls

ActiveX controls, 300–303
adding to Access forms, 400, 404, 410–417
adding to Access reports, 473, 478–479
aligning, 423
arranging in Access reports, 472, 483
bound controls, 411
conditional formatting rules for, 430–431
Control Source property, 411
ControlTip Text property, 412
formatting, 428–430, 486–487
form control properties, 411–415
form controls, 143–144, 290–306
grouping, 145
labeling, 298
layouts of, 423–427
Name property, 411
order of, changing, 423
positioning, 484
properties of, managing, 147–150
unbound controls, 411
Visible property, 411

Controls group (Word), 25, 27, 139
Design Mode, 143
legacy controls, 138–139

ControlTip Text property, 412
conventions of book, v
Convert Form’s Macros To Visual Basic command 

(Access), 418
copying, configuring options for, 6
CorrectAddress, 119
correlations, calculating, 243
corrupted database files, repairing, 323–324
count functions, 52
COUNTIF function, 200
COUNTIFS function, 200
covariance, calculating, 243
Create Column dialog box (SharePoint), 516
Create Link command, 69
Create Microsoft Access Signed Package dialog box 

(Access), 317–318
Create New Building Block dialog box (Word), 60–61, 

62

Create New Data Types From Fields dialog box 
(Access), 361

Create New Style From Formatting dialog box (Word), 
43, 45, 148

Create New Template From This Database dialog box 
(Access), 316, 344

Create Relationship Wizard (Access), 343, 345
Create Source dialog box (Word), 83, 85
Create Sparklines dialog box (Excel), 218
Create View page (SharePoint), 513–514
Cross-Reference command (Word), 88
Cross-Reference dialog box (Word), 89
cross-references, 82, 87–90

inserting, 89–90
positional, 90

crosstab queries, 447–449
Crosstab Query Wizard (Access), 447–448
.crtx file name extension, 216
.csv files, passwords and, 175
Currency data type, 349
current navigation in SharePoint, 499
Current User Filter Web Part, configuring, 663
custom dictionaries, adding, 8
Custom Filter dialog box (Access), 374
custom groups on ribbon, 284
Customize Keyboard dialog box (Word), 132
Customize Ribbon command (Word), 20

D
Dashboard Designer, 657

launching, 659
dashboards

creating, 657–664
key performance indicators, displaying on, 661–662
Web Parts, adding and configuring, 659–664

data
exporting and importing, 166–167, 169
updating, 166–167

Data Analysis dialog box (Excel), 237
data analysis in Excel, 225–244

with Analysis ToolPak, 237–244
dual-axes charts, 222–225
histograms, 238–239
percentile and rank, 240
random number generation, 240–242
sampling, 242
with Solver, 233–236
sparklines, 217–222
trendlines, 212–216
what-if analyses, 225–236

data bars, 432–433
Data Connection Wizard (Word), 117
Data Connection Wizard (Excel), 265
data connections, 261–271

Access databases, 262–263, 267
creating, 261–268
existing, 268–269
Microsoft Query for, 267

data connections
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data connections (continued)
opening, 269
other data sources, 266–267
SQL Server databases, 265
text files, 265, 268
websites, 263–264, 268
XML files, 266

Data Connections library, 659
data definition queries, 450
Data Entry property, 419
data forms. See also forms

creating, 296–297
order forms, creating, 303–305

data macros, creating, 357–359
data sets

descriptive statistics of, 237–238
frequency, 238–239
percentiles, determining, 240
rank order, determining, 240
sampling, 242

data sources
connecting to shapes, 640
creating, 117
defining, 267
external, 261–271
headers in first row, 116
for mail merges, 114–121

data summary tasks (Excel), 199–206
Data Table dialog box (Excel), 228, 229
data tables (Excel). See also tables

two-variable tables, 228–230
updating calculations for, 196
what-if analyses with, 225, 227–230

data type application parts, adding to tables, 360
data types

creating, 361, 362
for database fields, 348–350

data validation circles, removing, 190
Data Validation dialog box (Excel), 187–188
data validation rules (Excel), 187–190

defining, 190
database objects

adding to custom categories in navigation pane, 
337–338

copying, 313
deleting, 334–335
dependencies of, 333
name maps, 332
Option Designers category, 328
PDF or XPS format, publishing as, 320–321
renaming, 331–334
saving as application parts, 339
saving as different types, 313
shortcut menu options, 331
in templates, 310
themes, applying to, 408, 409

database records
appending, 389–390, 443–444
archiving, 443–444
Cascade Delete Related Records option and, 445–446
cascading updates to, 382

deleting with queries, 445–446
filtering, 373–377
finding, 370–371
grouping in queries, 458
grouping in reports, 469, 476–478
referential integrity, enforcing, 382
searching, 356–357
selecting with queries, 436–442
sorting, 371–373
updating with queries, 445–446

database table relationships
creating, 381, 383
editing, 453
foreign keys, 378
many-to-many, 380
managing, 451–454
modifying, 382, 383
one-to-many, 380
one-to-one, 380
primary keys, 378–379
referential integrity, 382
viewing, 382

database tables
appending records to, 389–390, 443–444
creating in Design View, 347–359
creating with make-table queries, 442–443
data macros, defining, 357–359
Description property, 352
fields, creating and modifying, 360–369
filtering records in, 373–377
Filter property, 352
foreign keys, 378
ID field, 378
importing data into, 384–393
joining, 452–453
linked tables, 390–393
linking, 452
lookup fields, creating, 351–352
Order By property, 352
Orientation property, 352
primary key, specifying, 378–379
properties, setting, 352–355
Read Only When Disconnected property, 352
referential integrity, enforcing, 382
relationships among, 343
relationships, setting, 378–383
searching, 370–371
selecting records from, 436–451
sorting records in, 371–373
subdatasheets, 354–355, 355
table validation rules, defining, 353, 355

Database To Compact From dialog box (Access), 324
databases. See also web databases

Access application window options, 327
add-ins, managing, 329
application parts, adding, 339–346
backing up, 319, 320
blank forms, adding, 339–342
building, 360
caching options, 328
client settings, 329

data connections
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databases (continued)
compacting and repairing, 323–324
compatibility issues, 316, 322
connecting to Excel, 262–263, 267
creating and managing, 309–330
creating using a template, 310–312
datasheet view options, 328
digital signatures for, 317
encrypting, 325–326
executable files, 318–319, 320
filter lookup options, 327
general options for, 326
hosting within SharePoint, 635
importing data from Access databases, 386–387
importing data from Excel, 384–385
importing other formats, 389
importing Outlook data, 389
importing text files, 387–388
indexes, defining, 356–357
language-specific options, 328
linking to tables in, 390–391
navigation pane options, 327
Northwind database, 311
Object Designers category, 328
Open dialog box options, 313–314
opening for exclusive access, 314, 325
opening as read-only, 314
packaging and signing, 317–319
permissions, updating, 323
previous versions, displaying, 314
proofing options, 328
publishing to Access Services, 315, 321–322
publishing to SharePoint sites, 637–638
Quick Start application parts, using, 342–344
ribbon and toolbar options, 327
Save Object As command, 313
saving, 315–323
saving as client object, 321
saving in different format, 315–316, 319
saving as template, 316–317, 344–346
saving to SharePoint site, 319, 320
startup routines, specifying, 317, 345
Trust Center options, 329–330
user templates, applying, 344–346

Datasheet view (Access), 347
Add & Delete group, 360
field properties, setting, 367–370
fields, hiding and freezing, 363–364
fields, working with, 360–362
query results in, 439
records, sorting and filtering, 370–377
subdatasheets, 354–355
Table Tools Fields tab, 360, 367, 368

datasheet view (SharePoint), 510–511
deleting files in, 528–529

Date Filters command (Access), 374
date pickers, 26, 29, 144

adding to forms, 146
properties of, 147

Date/Time data type, 349

default program options (Word), setting, 3–8
Default Value field property, 365
Default View property, 418, 481
Delete button (SharePoint), 526–528
delete queries, 445–446
dependencies of database objects, 333
dependents, tracing, 186–187
Description field property, 368
descriptive statistics, 237–238
Descriptive Statistics dialog box (Excel), 237
design grid, showing and hiding, 422
Design tab (Word), 48
Design view (Access)

calculated fields, creating in, 461–462
control layouts, removing, 424
creating database tables in, 347–359
crosstab queries, creating in, 448–450
field properties, setting, 365–367
Field Properties area, 351, 365–367
fields, working with, 363
form controls, adding, 410–417
form controls, sizing and ordering, 422–423
form controls available in, 414–415
forms, creating and modifying, 396
opening new tables in, 348
primary key, setting, 378
queries, creating in, 438–441
Query Builder, opening in, 463
report layouts, removing, 484
reports, arranging in, 483
reports, creating in, 472–475
Tools group, 418

detail queries, 437
Developer tab (Excel), 273

displaying, 167
Map Properties, 168
XML group, 167

Developer tab (Word)
Code group, 129
Controls group, 25, 27, 129
displaying, 20, 129
Document Templates command, 20
Restrict Editing command, 154
XML group, 151

digital certificates
obtaining, 318–319
viewing details of, 318

digital signatures for databases, 317
directory mail merges, 104
Disable All Application Add-Ins option, 7
Disable All Macros Except Digitally Signed Macros 

options, 135
Disable All Macros With Notification option, 135–136
Discrete distributions, 242
Display For Review menu (Word), 77
Disposition Approval workflow, 532
#DIV/0! error value, 192
.docm file format, 137
document access, restricting, 15–17
Document Inspector, 176–179

Document Inspector
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document libraries, 509. See also files; SharePoint 
repositories

columns in, 536–537
creating, 509
deleting files in, 529–530
managing, 509–519
Open With Explorer option, 529–530
properties, editing, 510–521
sharing, 645
synchronizing between Outlook and SharePoint, 

644–646
uploading documents via browser, 596
View In Browser link, 656
Visio diagrams, publishing to, 641

document previews, 625–626
document properties. See also properties 

inserting, 62, 64
document references, defining in templates, 24
document set content type, 569

defining, 541–542
document sets, 539–544

adding documents to, 542–543
considerations for, 541
content types, 539–540
creating, 542
file name prefixes, 540
load times and, 541
Send To feature, 541
versioning for, 543

Document Templates command (Word), 20
Document Workspace template, 578
document workspaces, 576

members of, 578
setting up and using, 578–579
from Word documents, 578

documents
adding to document set, 542–544
adding to My Site, 596
advanced searches for, 628
bibliographies, 86–87
building blocks, adding, 60
character styles, creating and applying, 44–45
citations, 83–85, 91–92
combined, 80–81
comments, 74–75
creating and saving in SharePoint, 536–541
cross-references, 87–90
default file format in Word, 5
default save location in Word, 5
default unit of measurement in Word, 6
document workspaces, creating from, 578
editing restrictions, 13–15
editing with Office Web Apps, 656
encrypting, 17
Excel worksheets, inserting, 48
forms, 143–153
headers and footers, 65–67
images, adding to, 24
indexes, 95–101
macros in, 130–143
for mail merges, 104

merging, 78–80
Name property, 520
offline editing options, 5
page numbers, 65
passwords for, 17–18
protection, applying, 13–18
Quick Parts, inserting, 62–64
recent documents list in Word, 6
redirecting, 554
reusable content in, 59–68
reviewing, 80–81
Reviewing pane, 77
saving in document library, 537
sections, linking, 70–71
sharing in My Site, 594–595
source citations, 85–86
style area, 6
tables of authorities, 91–95
templates, applying, 18–31. See also templates
templates, basing on, 23, 27
text boxes in, 68–70
text styles in, 41–44
Title property, 521
trusted documents, 136
uploading to SharePoint site, 535–536
version control, 530–531, 543
Welcome page, 540
WordArt objects, inserting, 36
XML schema, attaching, 152

.dotm file name extension, 18, 131, 137
downloading database templates, 312
Draft view (Word), 42
Draw Borders group, 48
drawing tables, 47
drop caps, 40, 41
drop-down form fields, 156
drop-down lists, 25, 28, 144

adding to forms, 146
drop lines, 214
Drop Off Library, 554

directing users to, 554
dual-axes charts, 222–224
.dwp file name extension, 566
dynamic pages, 545

E
Edit Citation dialog box (Word), 84
Edit Document button (SharePoint), 521
Edit In Browser link, 656
Edit Links dialog box (Excel), 270
Edit Properties button (SharePoint), 521
Edit Recipient List command (Word), 118
Edit Relationships dialog box (Access), 381–382
Edit Source command (Word), 84
Edit Sparkline dialog box (Excel), 218
editing, protecting, 13–15
editing restrictions on forms, 154
electronic postage, adding, 124
e-mail messages, sending to group, 112–115

document libraries
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Enable All Content option, 136
Enable Content command (Word), 7
Enable Live Preview option, 4
encryption

for databases, 325–326
for documents, 17, 175

Envelope Options dialog box (Word), 124, 126
envelopes

creating, 121–127
electronic postage, adding, 124
feeding in printer, 126
mail merge, setting up for, 121–123
printing, 126

Envelopes tab (Word), 123
E-Postage Properties button (Word), 124
equations, labeling, 88–89
error checking, 191–194
Error Checking command (Excel), 192
error values, 192–193, 208
errors in formulas, correcting, 191–193
Evaluate Formula dialog box (Excel), 192
Excel 5.0 dialog sheets, 291
Excel Macro-Enabled Template (.xltm) format, 163, 

273
Excel Macro-Enabled Workbook (.xlsm) format, 273
Excel Services, 263, 635
Excel 2010

Access data connections, 262–263
ActiveX controls, 300–303
advanced chart features, applying, 211–224
Analysis ToolPak, 237–244
auditing formulas, 185–195
compatibility checking, 178
compatibility with earlier versions, 164
data analysis, applying, 225–244
data forms, creating, 296–297
data sources, external, 261–271
data summary tasks, performing, 199–206
data tables, 227–230
data validation rules, 187–190
Developer tab, 273
exporting data to Access, 384–385
exporting and importing data, 166–167, 169
form controls, inserting and manipulating, 290–306
formula errors, correcting, 191–193
formula options, manipulating, 195–198
functions, applying in formulas, 206–209
Goal Seek, 226–227
macro buttons, adding to ribbon, 284–286 
macros, creating and manipulating, 273–306
PivotCharts, applying and manipulating, 257–260
PivotTables, applying and manipulating, 244–256
properties provided by, 164
publishing data to SharePoint site, 636–637
Solver, 198, 233–236
sparklines, 217–222
table data, inserting from, 48–51
tables, creating, 47
tables, sharing workbooks and, 180
Watch Window, 193–194
what-if analyses, 225–236

XLStart folder, 275
XML, working with, 166–169

Excel Web Access Web Part, configuring, 663–664
executable files for databases, 318–320
existing documents, creating templates based on, 27
exponential trendlines, 213
exporting

from Access, 334
from Excel, 166, 169
Web Parts, 566

Expression Builder (Access), 463–466
IntelliSense in, 465
opening, 368
panes in, 464

Expression property, 367
expressions, 353

adding to queries, 461–462
entering in Zoom dialog box, 462–463
Expression Builder, 463–466
operators in, 461
square brackets in, 461

External Data Range Properties dialog box (Excel), 264
external data sources for Excel, 261–271
external information, storing as XML data, 166–170
external references (Excel), 269–270
Extract Database To dialog box (Access), 318

F
Field dialog box (Word), 111
Field list (Access), 398–401

opening, 400
Field Settings dialog box (Excel), 246
Field Size property, 365, 368
field validation rules, 368
fields, 62. See also query fields

adding to forms, 398–400
adding to reports, 468–470, 472
aligning and positioning in Design view, 403
comparing values in, 353
creating and modifying, 360–369
data types, 348–350
defining, 348
deleting, 362–363, 363
field codes, 54, 64
field relationships, setting, 115
filtering, 375
filtering recipient lists by, 105
finding, 99
hiding and freezing, 363–364
index entry fields, 97
indexing, 356–357
inserting, 63, 64, 360–362, 363
properties, setting, 365–370
renaming, 362
updating, 63
working with in Datasheet view, 360–363
working with in Design view, 363

figures, labeling, 88–89

figures, labeling
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file formats
compatibility with passwords, 175 
default save format in Word, 5

file types vs. content types, 568
files. See also documents

Content Type property, 524
content types, choosing, 523–524
default save locations in Word, 6
deleting from SharePoint, 526–530
encrypting with password, 17
inline editing of, 525–526
properties, editing, 520–521
uploading changes to SharePoint, 645

Fill-In rules, 111
fills, for text characters, 35
Filter And Sort dialog box (Word), 105
filtering

advanced filters, 375, 376
by form, 375, 376
PivotTable data, 248–249
queries as, 375, 376–377
recipient lists, 105
records, 373–378
reports, 492–493
saving filter as query, 375, 377
by selection, 374, 376

Find And Replace dialog box (Access), 370
Find Duplicates command (Word), 119
Finish & Merge command (Word), 104
flow of text, controlling, 68–71
font attributes, applying, 33–46
Font dialog box (Word), 33–34

Advanced tab, 37–39
Font tab, 34
Text Effects, 35–36

font scheme, defining or modifying, 410
fonts

in Access reports, changing, 486
default style in Word, 39
formatting, 34
ligatures, 38–39
number forms, 38–39
number spacing, 38
OpenType fonts, 38–39
stylistic sets, 38

footers and headers, 65–67
defining in templates, 24

foreign keys, 378
updating, 382

form controls (Excel). See also controls
alt text options, 299
check boxes, 293–294
colors and lines settings, 299
combo box controls, 292–293
command button properties, 299
command buttons, 291–292
inserting, 290–298
label controls, 295–296
labeling, 298
list box controls, 292–293
option buttons, 293–294

order form, creating, 303–305
positioning options, 298
print options, 298
properties, setting, 298–300
protection settings, 298
scroll bars, 294–295
size properties, 298
spin buttons, 294–295
types of, 290–291

Form Design command (Access), 401
Form Design Tools tab (Access), 395

creating and modifying forms with, 401–404
Format tab, 426–427
Header/Footer group, 417
Themes gallery, 408–409

Form Field button (Word), 155
Form Field dialog box (Word), 155–156
Form Field Help Text dialog box (Word), 157
Form Layout Tools tab (Access), 395

Format tab, 426–427
Header/Footer group, 417
Themes gallery, 408–409

Form view (Access), 396
Form Wizard (Access), 396–398, 402

subforms, creating, 398
Format Controls dialog box (Excel), 298–299
Format Data Series dialog box (Excel), 223
Format field property, 365
Format Page Numbers command (Word), 65
Format Painter button (Access), 429
Format Text Effects dialog box (Word), 35, 41
Format Trendline dialog box (Excel), 213, 214
formatting

autoformatting in Word, 11
character formatting, 33–41
character styles, creating and applying, 44–45
citation text, 92
conditional formatting for forms, 430–434
content controls, 148, 149
controls, 486–487
highlighting changes to, 75
index entries, 96
limiting, 154
live preview of, 4
PivotTables, 247–248
preserving or merging, 6
protecting, 13
reports, 486–488
slicers, 256
sparklines, 221–222
styles, creating and modifying, 41–44
table of authorities, 93–95
tables, 47–48
in templates, 162
tracking changes to, 6
trendlines, 214
in Word, 33–72
WordArt objects, 36
worksheets, 50–51

formatting marks, display options, 4
Formatting Restrictions dialog box (Word), 13

file formats
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forms, 395–434
Add Help Text button, 157
automating operations of, 411
backgrounds, modifying, 427–428
blank forms, 339–342, 398–401
check box fields, 156
conditional formatting, 430–434
control layouts, working in Layout view, 423–427
control properties, 411–415
control wizards, using, 415
controls, adding, 143, 400, 404, 410–417
controls, formatting, 428–429
controls, locking, 147–148
controls, sizing and ordering in Design view, 422–423
controls, types of, 412–415
creating, 143–153, 396–407
creating and modifying in Forms Design Tools tab, 

401–404
databases, linking to, 151
design grid, showing and hiding, 422
designing, 143–146, 341, 408–421
Detail section, 403
drop-down fields, 156
editing, restricting, 148
Field list, 398–399
fields, adding and removing, 155–158, 398–401
fields and objects, arranging on, 422–426
formatting, 426–434
Form Wizard, 396–398
gridlines, displaying, 424
headers and footers, 403, 417
help, adding, 150–151
layouts, 397, 403
locking and unlocking, 154–155
manipulating, 154–158
More Forms command, 407
navigation forms, building, 405–408
no content controls in, 152
order forms, creating in Excel, 303–305
properties, setting, 418–420
property sheet, displaying, 400, 402
record source, choosing, 399, 401
record source, queries as, 402
sections of, 396
subforms, adding, 398, 415–416
tab order, setting, 419–421
text fields, 156
themes, applying, 408–410, 426
title, logo, or date and time, adding, 401
updating, 417–421
views, opening in, 396
XML schemas, attaching, 151–154

Forms Services
configuring, 641–643
site collections, enabling on, 642

formula auditing arrows, 186–187
Formula dialog box (Word), 51–52
formulas (Excel)

array formulas, 201–205
auditing, 185–195
automatic updating, 195–197

circular references in, 197
dependents, 186–187
errors, correcting, 191–193
functions, applying in, 206–209
inputs and outputs, tracing, 185–187
iterative calculation options, 197–198
options, manipulating, 195–198
precedents, 186–187
tracing, 185–187
validating, 187–190
viewing, 186

formulas (Word)
editing, 54
field-code markers, 54
inserting, 54
protecting, 53
updating, 53
in Word tables, 51–55

freezing fields, 363–364
FREQUENCY function, 204
Function Arguments dialog box (Excel), 201, 207–208
functions (Excel)

applying in formulas, 206–209
array functions, 204
AVERAGEIF function, 200
AVERAGEIFS function, 201
built-in functions, 206–207
COUNTIF function, 200
COUNTIFS function, 200
errors in, correcting, 208–209
finding, 209
FREQUENCY function, 204
help topics for, 208
inserting, 209–210
SUMIF function, 199–201
SUMIFS function, 199–201
TRANSPOSE function, 204

functions (Word), 51–54

G
galleries

Access Themes gallery, 408–409, 475 
bibliographies, saving to, 87
building blocks in, 60, 61
categories in, 61
of source citations, 84
of text effects, 36–37
Word Gallery list, 61

General Options dialog box (Excel), 164
Get External Data dialog box (Access), 334, 384
global navigation, 499
global templates, 21–22
glow effects for text characters, 35
Go To command (Access), 370
Go To Document Information Panel button 

(SharePoint), 537
Go To Special dialog box (Excel)

Data Validation option, 189
Precedents or Dependents options, 186

Go To Special dialog box (Excel)
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Goal Seek
iterative calculations for, 198
what-if analyses with, 225, 226–227

gradients for text characters, 35
grammar

checking with spelling, 10
configuration options, changing, 8–13
marking errors as you type, 10
options for, changing, 8–13

Grammar Settings dialog box (Word), 10–11
Greeting Line command (Word), 108
greeting lines, inserting, 108–109
Grid Y/Grid X properties, 481–482
gridlines, displaying, 424
Group & Sort command (Access), 476
group box controls, 291
groups

permissions, setting and modifying, 575
in SharePoint, defining, 572
workbooks, setting up for, 161. See also sharing

H
headers and footers

for Access reports, 472, 480–481
built-in, in Word, 66
controls, 66–67
custom, designing, 67
defining in templates, 24
for forms, 403, 417
inserting in Word, 67
page numbers in, 65–66
in Word, 65–67

Hidden And Empty Cell Settings dialog box (Excel), 
219

hidden worksheets, 176
Hide In This Group command (Access), 338
hiding fields, 363–364
high-low lines, 214
Highlight Changes dialog box (Excel), 180–181
highlighting revisions in documents, 75
histograms

bins, defining, 238–239
displaying, 238–239
Pareto option, 239

history list of workflows, 533
home page (SharePoint)

editing, 548
setting, 548

Home tab (Word)
character formatting options, 33–34
Find, Go To, 70
Styles gallery, 42
Text Effects gallery, 36

hyperlink controls, 412
Hyperlink data type, 350
hyperlinks

in cross-references, 90
in documents, 70

I
IF function, 52
If Then Else merge rule, 110, 112
image controls, 414
images. See also background images

adding to documents, 24
as form backgrounds, 427–428

IME Mode/IME Sentence Mode field properties, 366
Import Objects dialog box (Access), 386
Import Specification dialog box (Access), 388
import specification files, 388
Import Spreadsheet Wizard (Access), 384
Import Text Wizard (Access), 387–388
importing

into Access, 334, 384–393
into Excel, 166–167, 169
saving settings for, 385, 388
Web Parts, 566

Index dialog box (Word), 97–98
index entry fields, 97
Indexed field property, 366
indexes

AutoMark files, 95, 97, 100
on columns, 610–611
creating, 95–101
for database tables, 356–357
editing entries, 99, 101
formatting entries, 96, 100
generating, 99
hiding sites from, 612–613
indented indexes, 98
index fields, viewing, 97
marking entries for, 95–97, 99
number of columns, 98
options, configuring, 97–99
page ranges, bookmarking, 96
run-in indexes, 98
subentries, creating, 96
text styles, 98–99, 100–101
updating, 99, 101

Info tab (Excel)
Prepare For Sharing area, 176
properties, viewing and editing, 164
Protect Workbook, Restrict Permission By People, 173

InfoPath forms
accessing, 643
creating, 643
publishing to SharePoint, 643

InfoPath 2010, 641–643
information rights management

document access options, 15–17
setting up, 16, 173

inline editing, 514–515, 525–526
inner joins, 452
Input Mask field property, 365
Insert Caption command (Word), 88
Insert Chart dialog box (Excel), 216
Insert Chart dialog box (Word), 54–55
Insert Citation command (Word), 83
Insert Citation gallery (Word), 85

Goal Seek
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Insert Field command (Access), 361
Insert Function dialog box (Excel), 207
Insert Hyperlink dialog box (Access), 412, 413
Insert Hyperlink dialog box (Word), 70–71
Insert key, 6
Insert Picture dialog box (Access), 403
Insert Slicers dialog box (Excel), 252
Insert Table dialog box (Word), 47–48
Insert Table Of Authorities command (Word), 93
Insert tab (Word), 60

Chart, 54
Header & Footer group, 65
Illustrations group, 54
Table, 47–48
Text Box, 68
Text group, 62

Inspect command (Excel), 177
IntelliSense in Expression Builder, 465
invalid data, checking for, 189–190
Issues application part, 342
italics, keyboard shortcut for, 33
items (SharePoint). See also SharePoint repositories

creating, 519–520
deleting, 526–530
inline editing of, 525–526
managing, 519–539
properties, conditions on, 523
properties, editing, 520–524
properties, validating, 523

iterative calculations, options for, 197–199

J
joins, 452–453

K
Keep Change History For option, 182
Keep Track Of Formatting option, 6
kerning, 37
key performance indicators (KPIs)

creating, 660–661
defining, 657
displaying, 661–662, 663
status list for, 659–660

Key Performance Indicator Web Part, configuring, 
661–662

keyboard, navigating documents with, 130
keyboard shortcuts

for character formatting, 33
global template settings for, 21
for macros, 131–134

keystrokes, assigning to macros, 281–282
keywords

for searches, 620–622
start, end, and review dates, 621

L
label controls, 291, 412

inserting, 295–296, 298
Label Options dialog box (Word), 125–126
Label Vendors list, 125
labels for document elements, 88–89
labels (mail)

creating, 121–127
customizing, 125
mail merge, setting up for, 121–123
printing, 127

language configuration options, 5
Layout tab (Word), 48

Data Group, 51
Layout view (Access)

control layouts, working with, 423–426
form controls, adding, 410–417
forms, creating and modifying, 396, 398–401
navigation forms, creating in, 405
report layouts, removing, 484
reports, building in, 470–471, 483

layouts, for reports, 469, 470, 483–486
layouts, control, 423–427

anchoring options, 425
cells, merging or splitting, 424
cells, positioning, 424–425
gridlines, displaying, 424
removing, 424
rows or columns, adding, 424
space between controls, 425
stacked layout, 423
tabular layout, 423–424

legacy controls
adding to forms, 144
command buttons, 138–139

legal blackline, 78
legal documents, tables of authorities for, 91–95
Library Tools tab (SharePoint), 510
ligatures, 38–39
Limits reports, 235
line controls, 414
linear trendlines, 212
Link Tables dialog box (Access), 391
linked database tables, 390–393

managing, 393
Linked Table Manager command (Access), 393
linking

document sections, 70–71
text boxes, 68–69

list box controls, 290–291, 414
building lists in, 148
properties, setting, 302
setting up, 292–293, 297

list box lookup fields, 351
List Box Wizard (Access), 415
List Tools tabs (SharePoint), 510
lists (Access), creating lookup fields from, 351–352

lists (Access), creating lookup fields from
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lists (SharePoint), 509. See also SharePoint 
repositories

content types in, 520
item properties, editing, 520–526
items, creating, 519–520
managing, 509–519
properties, editing, 510–519
searching, 611–612
views of, 510–511

Live Preview (Access), 408, 489
live preview (Word), enabling, 4
Load From Query command (Access), 375
logarithmic trendlines, 212
logical operators, 619–620
lookup fields

adding to forms, 400
creating, 350–352

Lookup Wizard (Access), 350–351
opening, 368

Lync 2010, 594

M
Macro dialog box (Excel), running macros from, 281
macro-enabled documents, 131, 137
macros

absolute or relative cell references in, 276
in Access, creating, 357–360
action macros, creating in Excel, 287–289
assigning, 291
built-in macros in Word, 137
calling other macros from, 279
command buttons, running from, 138–141
configuration settings in Word, 7
definition of, 129
enabling, 135–136
in Excel, creating and manipulating, 273–306
form fields, running on, 156
global template settings for, 21
keystrokes, assigning to, 281–282
modifying, 277–280
naming, 131, 274
Open event, running from, 283–284
operations in, 130
options, 137–143
Quick Access Toolbar button for, 141–143, 287
recording in Word, 130–133
recording and storing in Excel, 274–277
ribbon button for, 284–286
running, 134–135, 274, 281
running automatically, 137–138, 282–284
security settings, 135–137, 276–277
storage location, 131
in templates, 18, 24, 163
testing, 138
in VBA, 140–141
XLStart folder, 275

Macros dialog box (Word) Run button, 134

mail merge operations
Auto Check For Errors command, 112
default return address, 123
documents, editing and saving, 104
electronic postage, adding, 124
e-mail messages, sending to group, 112–115
envelopes and labels, creating, 121–127
errors, 104
executing, 103–114
external data sources, 114–121
fields, customizing, 105–106
merge fields, 107–109
merge rules, 110–112
Outlook contact items, 117–118
previewing results, 104
recipient list, 105–107
recipient list, modifying, 118–120
recipient list, source of, 104
saving documents of, 108
types of, 104

Mail Merge Recipients dialog box (Word), 118
data sources, editing, 119

mailing addresses, validating, 119
Mailings tab (Word), 103–104, 112, 121
Make Table dialog box (Access), 442
make-table queries, 442–443
Manage Data Tasks dialog box (Access), 388
many-to-many table relationships, 380
Mark Citation dialog box (Word), 92
Mark Index Entry dialog box (Word), 95–96
Match Fields command (Word), 115
maximum value, returning, 52
.mdb format, 105
Meeting Workspace template, 579
meeting workspaces

from Calendar lists, 580
setting up and using, 579–582

Members SharePoint security group, 572
Memo data type, 348–349
merge fields

adding, 107–109
on envelopes and labels, 122

merge rules, 110–112
Merge To E-Mail dialog box (Word), 113
merging

documents, 78–80. See  mail merge operations
workbooks, 182–184

metadata
search information in, 609
in SharePoint, 568, 569
visual representation of, 604–605

Microsoft Access Security Notice dialog box, 318
Microsoft Access 2010. See Access 2010
Microsoft Certification ID, iii
Microsoft Certified Professional website, iii
Microsoft Document Connection application, 596
Microsoft Excel Binary Worksheet format, 50
Microsoft Excel Macro-Enabled Worksheet format, 50
Microsoft Excel 97–2003 Worksheet format, 50
Microsoft Excel Worksheet format, 50
Microsoft InfoPath 2010, 641–643

lists (SharePoint)
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Microsoft Live Communicator, 594
Microsoft Office Specialist (MOS)

defined , i
expectations , ii

Microsoft Office Specialist program
benefits of, iii
book coverage of exams, iv
certification path, choosing , i
certification paths, listed, i
exams, described, iv
exam time limit, ii
exam tips, ii
logo, personalizing, iii
objective domain, ii

Microsoft Office Specialist Expert (MOS Expert)
defined, i
expectations, ii

Microsoft Office 2010. See Office 2010
Microsoft Office 2010 Tools Digital Certificate For VBA 

Projects, 318
Microsoft Query queries, as Excel data source, 265, 

267
Microsoft SharePoint. See SharePoint 2010
Microsoft SQL Server Reporting Services, 637
Microsoft Visual Basic for Applications (VBA), 129

macros, recording in, 140–141, 273
Microsoft Word. See Word 2010
Min Max Buttons property, 419
mini toolbar display options (Word), 4
minimum value, returning, 52
Modify Building Block dialog box (Word), 61
Modify Button dialog box (Word), 142
Modify Expression command (Access), 368
Modify Lookups command (Access), 368
Modify Style dialog box (Word), 42–43

New Documents Based On This Template option, 22
Modify Table Style command (Word), 48
modulus, returning, 52
More Forms command (Access), 407
More Functions command (Excel), 206
moving average trendlines, 213
moving averages, calculating, 243
My Content, 583, 594

Personal and Shared Document libraries, 595
My Links Web Part, 600
My Site, 583–606

accessing, 584
collaborating through, 593–600
colleagues, adding, 584, 586–587
colleagues, status changes, 587
configuring, 584–592
content, tagging and noting, 601–606
documents, adding to, 596
keywords, adding, 584, 586
Microsoft Office, connecting to, 595
Note Board, 601–606
organizational hierarchy, browsing, 598–599
personal documents, managing, 595–606
Personal Documents library, 594
profile, configuring, 590–606
profile status, updating, 593–606

RSS feeds, setting up, 588–606
saving Word documents to, 597
setting up, 585–606
Shared Documents, 594
sharing pictures and documents, 594–595
Tag Cloud, 602
themes, selecting, 584, 585, 588
Web Parts, adding, 599–600

My Site home page, 584
Web parts on, 599–600

My Templates, 19, 163, 310

N
#N/A error value, 193
Name AutoCorrect (Access), 332–333
Name field property, 368
Name property, 411
#NAME? error value, 192
navigation

cross-references, linking, 82
with keyboard, 130
of long documents, 70–71

Navigation Buttons property, 418
Navigation Caption property, 418
navigation controls, 413
navigation forms, 405–408

setting as default, 406
navigation pane (Access)

category, sort order, and view options, 336
configuring, 331–339
custom categories, 336–337
deleting objects in, 334–335
displaying, 311
form entries on, 340
grouping objects in, 335
importing and exporting data from, 334
options, setting, 327, 335–339
renaming objects in, 331–334
showing and hiding, 331
Tables And Related Views category, 335

Navigation Pane (Word), jumping to sections with, 70
New Address List dialog box (Word), 105
New Documents Based On This Template option, 22, 

43
New Formatting Rule dialog box (Access), 431
New Item dialog box (SharePoint), 519
New Page dialog box (SharePoint), 547
New Query dialog box (Access), 436–437, 447
New Table Style command, (Word) 48
New Web Query dialog box (Excel), 263
normal distributions, 241
Normal template (Normal.dotx), 18, 21
Northwind database, 311
NOT() function, 52
Note Board, 601–602
note content commenting, 583
notes, adding to content, 601–606
#NULL! error value, 193
Number data type, 349

Number data type
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number forms, 38–39
number spacing, 38
#NUM! error value, 193

O
objective domain in MOS exams, ii
objects. See also database objects

action macros, assigning to, 287–289
hiding, 288–289

Office 2010. See also Access 2010; Excel 2010; Outlook 
2010; SharePoint 2010; Word 2010

connecting to My Site, 595
searching SharePoint sites from, 616–617
spelling and grammar configuration options, 8–9

Office 2011, Microsoft Document Connection 
application, 596

Office Web Apps, 655–656
editing documents with, 656
limited functionality of, 656

Office.com
database templates, 312
Word templates, 19, 21

offline client availability, 613
OLE Object data type, 350
one-to-many table relationships, 380
one-to-one table relationships, 380
online edition

accessing, ix
downloading, x

Only In This Document option, 43
Open dialog box (Access), 313–314
Open event, running macros from, 283, 284
Open Index AutoMark File dialog box (Word), 97
Open Source List dialog box (Word), 86
Open With Explorer option (SharePoint), deleting files 

with, 529–530
OpenDocument Spreadsheet format, 50
OpenType fonts, formatting options, 38–39
option buttons, 291, 414

inserting, 293–294, 297
properties, setting, 302

option group controls, 414
OR() function, 52
order forms, creating, 303–305
Organization Browser Web Part, 598–599
organizational chart, browsing, 630
organizational hierarchy, browsing, 598
Organizer, managing templates with, 29–31
outer joins, 453
Outline view (Word), 42
outlines for text characters, 35
Outlook Navigation pane, SharePoint lists in, 644–645
Outlook 2010

contact lists, synchronizing with SharePoint, 646–647
document libraries, synchronizing with SharePoint, 

644–646
exporting data to Access, 389
Instant Search feature, 645
mail merge contact items, 117–118

SharePoint, synchronizing with, 644–648
task lists, synchronizing with SharePoint, 647–648

overtype mode, 6
Owners SharePoint security group, 572

P
page break controls, 414
page display (Word), configuring, 4
page layout, defining in templates, 24
Page Number command (Word), 65
Page Number Format dialog box (Word), 65–66
page numbers, formatting, 65–66
page ranges, bookmarking, 96, 100
Page Setup dialog box (Access), 489
Page Setup tab (Access), 488
page templates (SharePoint), 545
pages (SharePoint)

creating, 546–547
deleting, 548
editing, 547–548
managing, 545–549
search box, 607
Site Pages library, 546
title, description, and icon for, 548

paragraph attributes
applying, 33–46
styles, 41–44

parameters, defining, 440–442
pass-through queries, 450
passwords

for databases, 325–326
for documents, 15–18
for templates, 27, 162–163
for workbooks, 175–176
for worksheets, 172

Paste Options button (Word), 6
pasting, configuring options for, 6
Patterned distributions, 242
PDF files, publishing database objects as, 320–321
people

advanced searching for, 631–632
searching for, 618, 629–632

people with disabilities, accessibility checking for, 177
percentiles, determining, 240
PerformancePoint Content library, 658, 659
PerformancePoint Services, 657
Permission dialog box (Word), 16

user permissions, 173
permissions

assigning to SharePoint groups, 573
Read or Change permissions, 173
setting, 16
on SharePoint sites, 550, 574–576
user accounts, appending to, 574

personal documents, managing, 595–606
Personal Documents library, 594

documents, deleting from, 597
folders, adding, 597
setting as location, 596–606

number forms
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Personal Macro Workbooks, 275
Auto_Open macros, 282

personal sites (SharePoint), 583–606
note content commenting, 583
tagging, 583

Personal.xlsb files, 275
Phone Call Memo content type, 571
Picture Alignment property, 427
picture controls, 25, 28, 144

adding to forms, 146
Picture property, 427
Picture Size Mode property, 427
Picture Tiling property, 427
Picture Type property, 427
pictures, sharing in My Site, 594–595
PivotCharts

analysis options, 258
calculated items and fields in, 259
creating, 257–258, 260
design options, 258
fields, adding, 257
formatting options, 258
layout options, 258
manipulating, 257–260
rearranging, 260
slicers, inserting, 259
view, changing, 258–260

PivotTables
building, 244–248
calculated fields, defining, 251, 255
calculated items, defining, 251, 255–256
Calculations group, 250
creating, 254
data, managing, 249–250
data, sorting and filtering, 248–249
data source, changing, 249–250, 254
external data sources for, 261
field headers, 248–249, 254
field layout options, 246
Field list, 245–246, 259
fields, adding, 246
fields, naming, 246
fields, subtotaling, 246
filtering data with slicers, 252–253, 256
formatting, 247–248
label filters, 249
manipulating, 244–256
moving, 250
PivotCharts, inserting, 257
report filter, 252
showing values, 255
slicers, formatting, 256
slicers, inserting, 252–253, 256
summarizing values in, 251, 255
value filters, 249
view of data, changing, 250

placeholder text in templates, 24
placeholders for citations, 83, 85
plain text controls, 144
Poisson distributions, 241

polynomial trendlines, 212
positional arguments, 53
power trendlines, 212
precedents, tracing, 186–187
Prepare For Sharing area, 176
Preview Results command (Word), 112
primary key

indexing, 356
multifield, 378
removing, 379
specifying, 378–379
uniqueness of, 390

Print Preview view (Access), 492
Print view (Access), 467–468
printing

envelopes and labels, 121–127
Word options, configuring, 4

procedures, 129
product, calculating, 52
Product Numbers list, 125
properties

advanced properties in Excel, 165–166
of controls, 411–415
custom properties in Excel, 165–166
Excel-provided properties, 164
of forms, 418–419
read-only, 164
of SharePoint sites, setting, 553
of workbooks, setting, 164–166

property sheet (forms)
for Access reports, 481–483
All tab, 412
Data tab, 411, 419
Event tab, 411
Format tab, 411, 418–419, 427–429
Other tab, 411

Property Sheet command (Access), 400, 417–422
Protect And Share Workbook command (Excel), 180
Protect Shared Workbook dialog box (Excel), 180

Sharing With Track Changes option, 180
Protect Workbook Structure command (Excel), 170
Protected Mode, 7
protection

applying to documents, 13–18
blocking authors, 15
for change tracking, 180
for content controls, 26
for editing, 13–15
for formulas, 53
starting enforcement of, 14–15
for templates, 27
users, enabling for, 14
for workbooks and worksheets, 170–173

Publish Access Application dialog box (SharePoint), 
637

publishers, trusted, 330
publishing

databases to SharePoint sites, 637–638
Excel worksheets to SharePoint sites, 636–637

Publishing sites, page types, 545–546

Publishing sites, page types
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Q
queries

adding fields to, 439
advanced searches with, 627–628
appending records with, 443–444
calculated fields, generating, 461–465
calculating totals with, 457–460
constructing, 435–451
crosstab queries, 447–449
data sources, adding and removing, 451–452
deleting records with, 445–446
expressions, adding to, 461–462
field names, customizing, 459
vs. filters, 375
as form record source, 402
getting values from, 351
grouping records in, 458
joins, 452–453
make-table queries, 442–443
managing tables and relationships, 451–454
parameters, defining, 440–442
Query Designer, 438–441
records, selecting with, 436–442
running, 439
select queries, 436–442
Simple Query Wizard, 436–438
sort order of returned records, 456–457
Sort row, 456
summary data, calculating, 458–460
Total row, 458
updating records with, 445–446

Query Builder (Access), opening, 402
Query Design command (Access), 435–436
Query Designer (Access)

adding and removing tables from, 451–452
building queries with, 438–441
field names, customizing, 459
fields, changing, 454–455
joins, managing, 452–453

query fields
adding, removing, and rearranging, 454–455
manipulating, 454–457
selecting multiple fields, 439
showing and hiding, 456

Query Parameters dialog box (Access), 440–441
Query Tools Design tab (Access), 436

Query Setup group, 451
Query Type group, 445, 450
Results group, 439, 442, 444
Show/Hide group, 439, 440, 458

Query Wizard command (Access), 435
Quick Access Toolbar

Compare And Merge Workbooks command, adding 
to, 182

Forms button, adding, 296
macro buttons, adding to, 141–143, 287
modifying buttons and icons, 142

quick forms, creating, 396, 398

Quick Launch bar (SharePoint), 499–501
adding content to, 502–503
creating documents from, 538
headings in, 500
Recycle Bin, 501, 558
uploading documents from, 536

Quick Parts
inserting, 62–64
saving, 62–64

Quick Start application parts, 342–344
adding to tables, 360, 362
creating, 361

Quick Styles, creating, 43, 44
quick tables, inserting, 47

R
Random Number Generation dialog box (Excel), 

240–241
random numbers

distribution options, 241–242
generating, 240–242

rank order, determining, 240
rank reports in SharePoint, 581
ratings, 603–604
read access, password for, 162
Read permission, 16, 173
readability statistics, showing, 10
Really Simple Syndication. See RSS feeds 
Recent Templates (Access), 310
recipient lists

building, 105–107
duplicate entries, 119
editing, 120
Outlook contact list as, 117–118
refining, 120

recipients
excluding from mail merge, 118
finding, 112
information about, editing, 119
information about, source of, 114
sending e-mail messages to, 112–113

Record Macro dialog box (Excel), 274–275
Record Macro dialog box (Word), 131
Record Selectors property, 418
Record Source property, 482
record validation rules, 368
records. See database records
rectangle controls, 414
Recycle Bin

restoring items from, 549
in SharePoint, 558–560

#REF! error value, 193
reference pages

bibliographies, 86–87
citations, adding, 83–85
creating, 82–91
cross-references, 87–90
sources, managing, 85–86

queries
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References tab (Word), 82
Captions group, 88
Citations & Bibliography group, 83
Index group, 95
Table Of Authorities group, 91

referential integrity, enforcing, 382
Refinement panel in search results, 619, 623–624
reflection effects for text characters, 35
regression analysis, trendlines in, 212
Reject menu (Word), 81
Relationship Reports, 382
relationships, in database tables, 378–383
Relationships window (Access), 380–381
relative cell references in macros, 276
Remember Dimensions For New Tables option, 47
Remove Layout command (Access), 424
Rename Shortcut command (Access), 338
replies to comments, 74
Report Center, Microsoft SQL Server Reporting 

Services for, 637
Report command (Access), 468
Report Design command (Access), 468, 472–474
Report Layout (or Design) Tools Design tab (Access)

Add Existing Fields command, 472
Header/Footer group, 480
options on, 475
Property Sheet, 481
Sizing & Ordering group, 481
Themes Gallery, 475
View menu, 492

Report Layout (or Design) Tools Format tab (Access)
Background Image, 486
Control Formatting group, 487

Report view (Access), 467, 492
Advanced Filter/Sort button, 493
filtering records in, 492–493

Report Wizard (Access)
creating reports with, 468–470
Show Me More Information button, 469

reports
Access reports, 467
arranging controls on, 472, 483
background images for, 486
column settings, 489, 491
conditional formatting for, 487–488
controls, adding, 473, 478–479
creating, 468–474
creating in Design view, 472–474
creating in Layout view, 470–472
creating with Report Wizard, 468–470
Default View property, 481
fields, adding, 468–469, 470, 472
formatting, 486–488
Grid Y and Grid X properties, 481–482
grouping records for, 467, 469, 476–478
headers and footers, 472, 480–481

layouts for, 469, 470, 483–486
page layout, changing, 489–491
page size, specifying, 488–489
properties, managing, 481–482
Record Source property, 482
sections, hiding, 481
sections of, 467
SharePoint Web Analytics reports, 581
Solver reports, 235
subreports, 479–480
summarizing values in, 477–478
themes, applying, 475–476
viewing, 467
views of, 492

repositories. See SharePoint repositories
Required field property, 366
Research pane in Office 2010, 616–617
Restrict Editing command (Word), 27, 154
Restrict Formatting And Editing pane (Word), 13–15, 

154
Review tab (Excel)

Change group, 179
protection options, 170
Track Changes, 180

Review tab (Word), 73
Compare, 78
Track Changes, 75

reviewers, revisions by, 78, 81
reviewing changes, 181–182
Reviewing pane (Word), 77

working in, 80
revision marks vs. comments, 74
revision tracking, 75–78
ribbon

adding buttons to, 284–286
Compare And Merge Workbooks command, adding 

to, 182
commands on, vii
customizing in Word, 6, 20
Developer tab, 129
options for, 327
Protect group, 15
Table Tools tabs, 48

rich text controls, 25, 143
root element, adding to documents, 151
rounding values, 52
rows and columns

inserting, 484
repositioning, 484

R-squared values, 216
calculation of, 212

RSS feeds
on My Sites pages, 588–589
for search results, 624–625
URLs for, 588–589

RSS Viewer Web Part, 588, 590

RSS Viewer Web Part
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S
Sample Templates (Access), 310
sampling data, 242
Save & Publish page (Access), 313, 315–323

Save Database As option, 315–320, 344
Save Object As option, 320–322

Save As Query command (Access), 375
Save AutoRecover option, 5
Save Chart Template dialog box (Word), 57
Save Object As command (Access), 313, 320–321
Save Selection As New Quick Style option, 43
Save Selection To AutoText Gallery command, 62
Save To SharePoint dialog box (Access), 319
saving

default file format in Word, 5
templates, 163

Scenario Manager (Excel), 225
what-if analysis with, 230–233

scenario reports, 231, 233
Scenario Values dialog box (Excel), 231
scenarios

defining, 232
deleting, 233
editing, 231, 233
merging, 232
results of, 232
values, inserting, 231
what-if analyses with, 225, 230–233

Schema Settings dialog box (Word), 151
schemas, XML, 151
ScreenTips

defining text for in Excel, 189
display options, configuring in Word, 4

scroll bar controls, 291
inserting, 294–295, 297
properties, setting, 302

scroll bars (Word), 1, 159, 307, 495
Scroll Bars property, 418
search alerts, 624–625
Search And Offline Availability page (SharePoint), 

612–613
Search Center

best bets, creating, 621
People search facility, 629–632
Refinement Panel, 619, 623–624
searching with, 618–620
search suggestions, 618

search results
for advanced search, 627–630
alerts for, 624–625
best bets, 620–623
browsing, 618–620
previewing content in, 607
Refinement panel, 623–624
refining, 607, 623–624
for repositories, 610–611
RSS feeds, setting, 624–625
in SharePoint 2010, 607–608
viewing, 618–626
in Windows Explorer, 616

Search Settings site collection feature, configuring, 
609

search visibility, setting, 610, 612–613
searching. See also search results; SharePoint 2010 

search
advanced searches, 627–629
document previews, 625–626
indexed columns, 610–611
keyword terms for, 620–622
logical and relational operators, 619–620
metadata, 609
for people, 629–631
SharePoint lists, 611–612
on SharePoint properties, 619

sections
linking, 70–71
pagination of, 66

security groups in SharePoint, 572
Security Options dialog box, 136
security settings

for ActiveX controls, 302–303
for Excel macros, 276–277
for Word macros, 135–137

Select Changes To Accept Or Reject dialog box (Excel), 
181–182

Select command (Access), 370
Select Data Source dialog box (Word), 55, 115–116, 

117
Select Files To Merge Into Current Workbook dialog 

box (Excel), 182
select queries, 436–442
self-signed digital certificates, 318
Send E-Mail Messages command (Word), 113
Sensitivity reports, 235
Set Bookmark rules, 112
set cells, 226
Set Database Password dialog box (Access), 325
shadow effects for text characters, 35
Share Workbook command (Excel), 179
Share Workbook dialog box (Excel), 179–180
Shared Documents library

documents, deleting from, 597
documents, uploading to, 594–595
folders, adding, 597
viewing contents of, 501

SharePoint Central Administration facility, 633
SharePoint Designer, 513

views, modifying, 515
SharePoint FAST Search, document preview 

capabilities, 625–626
SharePoint Foundation 2010 workspace, protecting 

documents in, 15
SharePoint repositories, 497. See also document 

libraries; items (SharePoint); lists (SharePoint)
aggregation options, 511
column information, integrity of, 517
column names, 517
column validation, 517
columns, calculations on, 515
columns, creating, 516–519
columns options, 514, 516, 519

Sample Templates (Access)
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SharePoint repositories (continued)
content type management, assigning, 570
content types, assigning, 570–571
creating, 509
datasheet view, 510–511
default view, 511
inline editing of, 514–515, 525–526
notes, adding, 602
offline access to, 648
properties, editing, 510–519
rating items in, 603–604
RSS feeds from, 588–589
search visibility settings, 610
searching, 610–612
tags, adding, 603
version control, 530–531
view types, 512
views, creating, 512
views, deleting, 515
views, modifying, 511–516
views, switching, 516
workflow settings, 534–535

SharePoint ribbon, 499
Browse item, 499
Edit page icon, 499
Library Tools tab, 510
List Tools tabs, 510
Page item, 499
Site Actions menu, 499, 500
Site Settings option, 500

SharePoint Search Center site, 609
SharePoint Server Enterprise Site Collection features, 

642
SharePoint Server Publishing Infrastructure feature, 

551
SharePoint sites

access, managing, 572–576
administering, 502, 550–561
alerts, viewing, 555–556
announcements lists, creating, 509
appearance, modifying, 556–558
breadcrumb trail, 499, 506–509
collaborative sites, 583
content, copying, 551–552
content, deleting, 558
content, organizing, 551–553
Content And Structure page, 551–552
Content Organizer, 553–555
content types, managing, 568–572
creating and configuring, 550–551
current navigation, 499
dashboard elements, building in, 657
databases, publishing to, 637–638
databases, saving to, 319, 320
default SharePoint team site template based, 497
document sets, 539–544
documents, copying to local computer, 654
documents, uploading to, 535–536
global navigation, 499

group permissions, setting, 574–576
groups, defining, 572–574
hiding from indexing, 612–613
InfoPath forms, publishing to, 643
inventory summary information, viewing, 581–582
libraries, displaying, 501
lists, viewing all, 501
navigating the hierarchy, 498–508
navigation options, 498
pages, creating, 546–547
pages, deleting, 548
pages, editing, 547–548
pages, managing, 545–549
people searches from, 631
permissions, 510, 512, 515, 526
personal sites, 583–606
Quick Launch bar, 500–501. See also Quick Launch 

bar (SharePoint)
ratings, 603–604
recovering data, 558–560
search box, 607
search columns, setting up, 610–611
search visibility, setting, 612–613
searching, 608–614, 618
searching from Office 2010, 616–617
searching from Windows Explorer, 614–616
Shared Documents library, 501
site activity, monitoring, 581–582
Site Collection Recycle Bin, 559
site collections, 498
Site Pages library, 546
Site Settings page, 502
social feedback features, 601–606
spreadsheets, publishing to, 636–637
subsites, 498, 572
synchronizing with workspaces, 651–652
tags, 602–603
Task content type, 569
themes, applying, 557
traffic summary information, viewing, 581–582
tree view, 556–557
user permissions, setting, 574–575
users, adding to groups, 572–574
Web Parts, managing, 561–567
wiki pages, 561
workbooks, sharing in, 263
workflows, managing, 531–535
workspaces, creating, 576–580

SharePoint Team Site template, 546
SharePoint 2010. See also SharePoint repositories; 

SharePoint sites; site administrators
breadcrumb trail, 506–509
contact lists, synchronizing with Outlook, 646–647
dashboards, creating, 657–664
document libraries, synchronizing with Outlook, 

644–646
document sets, working with, 539–544
documents, offline editing of, 5
exporting data to Access, 389

SharePoint 2010
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SharePoint 2010 (continued)
list items, managing, 519–539
lists and document libraries, managing, 509–519
navigating site hierarchy, 498–508
people search feature, 629–632
ratings, 603–604
Site Pages page library, 546
static and dynamic pages, 545
tag clouds, 604–605
task lists, synchronizing with Outlook, 647–648
Word docs, creating and saving in, 536–541

SharePoint 2010 InfoPath Forms Services, 641–643
SharePoint 2010 search, 607–632

advanced searches, 627–629
for people, 629–632
results, refining, 607
results, viewing, 618–626
search alerts, 624–625
site level searching, 608–614

SharePoint 2010 Server, 633
SharePoint 2010 Services

Access Services, 635
configuring, 634–644
for Excel, Access, and Visio, 635–644
Excel Services, 635
Outlook, synchronizing with, 644–648
Visio Services, 634

SharePoint 2010 Workspace, 648–655
Content pane, 652
File tab, 650
Folders pane, 652
Home tab, 650
Items pane, 653
offline options, 654–655
online options, 655
synchronizing, 655
Sync tab, 651
View tab, 651–652

SharePoint Web Analytics, 581
sharing

protecting editing for, 13–15
task lists, 648
workbooks, 179–181, 183

Sharing With Track Changes option, 180
shortcut keys, assigning to macros, 281–282
Show Date Picker field property, 367
Show Document Panel command (Excel), 166
Show Formulas command (Excel), 186
Show Markup menu, 77
Show Mini Toolbar On Selection option, 4
Show Readability Statistics option, 10
Show Table dialog box (Access), 438–439

opening, 451
Shutter Bar Open/Close Button (Access), 331
SIGN() function, 52
Simple Query Wizard (Access), building queries with, 

436–438
site actions, creating repositories with, 509

site administrators, 550
access, managing, 572–576
alerts, removing, 555–556
best bets, creating, 621
Content Organizer feature, using, 553–555
personal view modifications, 599
Recycle Bin, access to, 559
search, working with, 608
second-stage Recycle Bin, accessing, 559
SharePoint Services applications, configuring, 635
site activity, analyzing, 581–582
site appearance, modifying, 556–558
site collection features, enabling, 658
site content, organizing, 551–553
themes, setting, 585
user profile management, 591
Web Parts, hiding, 564

site analytics, viewing in SharePoint, 581
site collection features, enabling, 658
Site Collection Recycle Bin, 559
site collections, 498

Forms Services, enabling on, 642
Office Web Apps, enabling on, 655
search settings for, 609

Site Pages library, 546
Site Permissions command (Access), 323
Site Settings page (SharePoint), 502
site templates (SharePoint), 546, 550
Slicer Settings dialog box (Excel), 253
slicers

formatting, 256
inserting in PivotCharts, 259

Smart Tags field property, 366
social feedback, 601–606
Solver (Excel)

changing cells, defining, 233, 236
constraints, defining, 233, 234, 236
loading, 234, 236
objective or target, defining, 233, 236
precision value, 236
reports, 235
solving methods, 235
what-if analyses with, 225, 233–236

Solver Options dialog box (Excel), 236
Solver Parameters dialog box (Excel), 234
Solver Results dialog box (Excel), 235
Sort And Filter dialog box (Word), 119
Sort Records tab (Word), 105
sorting records, 371–373
source citations

adding, 83–85
copying, 86
managing, 85–86
master list, 86

Source Manager, 85–86
source tables, managing, 451–454
Sources.xml, 86
Sparkline Tools Design tab (Excel), 218

SharePoint 2010
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sparklines, 217–222
adding to worksheets, 218, 221
axes, displaying, 220, 222
editing data of, 218, 221
empty and hidden cells in, 219, 221
formatting, 221–222
grouping and ungrouping, 218, 220
markers in, 219, 221
range of, expanding, 218
styles, applying, 219
switching between, 219

spelling
checking as you type, 9
configuration options, 4
configuration options, changing, 8–13
contextual spelling, 9

spin buttons, 290
inserting, 294–295, 297
properties, setting, 302

spreadsheets. See also workbooks; worksheets
publishing to SharePoint site, 636–637
as Word tables, 48–50

SQL Server Analysis Services cube files, as Excel data 
source, 265

SQL Server databases, as Excel data source, 265
square brackets, enclosing identifiers in, 461
stacked form layout, 423
stacked report layout, 470, 484
Stamps.com, 119
Start Enforcing Protection dialog box (Word), 14–15
Start Mail Merge command (Word), 104
static pages, 545
statistical analysis, 237
status bar, recording macros with, 133
status lists

creating, 660
for key performance indicators, 659–660

Step By Step Mail Merge Wizard (Word), 104
structure

common structure in templates, 162
protecting, 171, 172

Structured Query Language (SQL), 450
style area pane, 42
styles

character styles, creating and applying, 44–45
creating, 41–44
default, 42
defining in templates, 23
modifying, 41–44
for PivotTables, 247
restricting use of, 13
table styles, 48
viewing, 42

Styles gallery (Word), 42
adding styles to, 43

Styles pane (Word), New Style option, 44–45
stylistic sets, fonts, 38
Sub and End Sub statements, 279

subdatasheets, 354–355
Subform In New Window command (Access), 418
Subform Wizard (Access), 415–416
subforms, 398, 414–416
subprocedures

inserting, 280
saving code as, 279

Subreport Wizard (Access), 479
subreports (Access), 414, 479–480
subsites, 498, 572

URLs of, 498
SUMIF function, 199–201
SUMIFS function, 199–201
summary queries, 437, 458–460
summing data, 53, 199–201

T
tab controls, 412
Tab Index property, 420
Tab Order command (Access), 418–421
tab order for forms, 419–421
table of authorities

categories, 92, 94
citations, marking, 91–92, 94
creating, 91–95
formatting and aligning, 93–95
options for, 93
styles, modifying, 95

Table Of Authorities dialog box (Word), 93
table cells. See also cells

specifying, 53–54
table relationships. See database table relationships
Table Tools tabs (Word), 48
tables. See also database tables

cell references, 53
data, inserting from Excel, 48–51
in Excel, 227–230 
formatting, 24, 47–48
formulas and calculations in, 51–54
inserting, 47–48
labeling, 88–89
as recipient list data source, 116
in Word, 46–59

tabs on ribbon, customizing, 284–286
tabular form layout, 423–424
tabular report layout, 470, 483
Tag Cloud Web Part, 604–605
tag clouds, 604–605
tags, 583, 602–603

adding, 604
filtering, 604
managing, 605
reviewing, 605

Task content type, 569

Task content type
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task lists, 533
sharing, 648
synchronizing with Outlook, 647–648

technology certification, benefits of, i
templates

applying to documents, 18–31
attaching, 21
based on another template, 27
based on existing document, 27
building blocks, saving in, 61
building blocks definitions, 24
for charts, 56, 58, 216–217
content controls in, 24–28
creating in Word, 23–29, 28
databases, creating with, 310–312
databases, saving as, 316–317
default location in Word, 6, 19
designing, 162
document references definitions, 24
document templates, 21
for document workspaces, 578
finding, 19
forms as, 143
functions of, 18
global templates, 21–22
header and footer definitions, 24
image definitions, 24
layout-related settings, 24
macros in, 24, 163
managing with Organizer, 29–31
modifying, 22–23
password protecting, 27, 162–163
placeholder text, 19, 24
sample templates, 19
save locations, 163
for SharePoint, 545
for SharePoint workspaces, 576
style definitions, 23
table formats, 24
using, 19–21
workbooks, saving as, 161–164

Templates And Add-Ins dialog box (Word), 20, 21
Add Schema, 151
Automatically Update Document styles option, 22

Templates dialog box (Excel), 163
Templates folder, 22, 310

saving templates to, 23
Test Validation Rules command (Access), 353
text

character spacing, 37
character styles, creating and applying, 44–45
converting to table, 47
drop caps, 40
font formatting, 34
formatting, 33–46
kerning, 37
ligatures, 38–39
number forms, 38–39
number spacing, 38

OpenType fonts, 38–39
styles, creating and modifying, 41–44
styles, creating from, 43
stylistic sets, 38

Text Align field property, 366
text box lookup fields, 351
text boxes, 412

drawing, 68
linking and unlinking, 68–70

text content controls, 25, 28
Text data type, 348
text effects

applying, 35–36, 41
applying from Home tab, 40–41
WordArt objects, 36

Text Effects gallery, 36
text fields

combining values of, 461
properties of, 365–366

text files. See also documents
connecting to Excel, 265, 268
importing into Access, 387–388
linking Access databases to, 392

Text Filters command (Access), 374
text form fields, 156
themes

color scheme, modifying, 409, 428
font scheme, modifying, 410
for forms, 408–410, 426
for My Site, 584, 585, 588
for reports, 475–476
for SharePoint sites, 557

.thmx file name extension, 408
Three-State workflow, 532
Tip paragraphs, v
toggle button controls, 414
top-level sites, 498

navigating to, 508
Totals command (Access), 476, 477
totals queries, 459–460
Trace Dependents command (Excel), 185–187
Trace Error command (Excel), 192–193
Trace Precedents command (Excel), 185–187
Track Changes Options dialog box (Word), 75–76
tracking changes, 75–78

conflicts, 180
formatting changes, 6
options for, 76, 181
protecting, 180
reviewing changes, 181–183
turning on, 180, 183
updating changes, 179
user name and initials of, 77
viewing changes, 181
views, 77
in workbooks, 179–181

traffic to SharePoint sites, 581–582
TRANSPOSE function, 204
trend reports in SharePoint, 581

task lists
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trendlines
adding, 212–216, 214
applying, 213
equations for, 214, 215
forecasting with, 214, 215
formatting options, 214, 215
intercept, setting, 215
line styles, 214
naming, 213
removing, 216
R-squared values, displaying, 216
types of, 212–213

troubleshooting Excel formulas, 192
Trust Center, 7, 329–330

ActiveX control security settings, 302
macros security options, 276–277
opening, 135

trusted documents, 7, 136, 330
trusted locations, 329–330

documents stored in, 136
managing, 7
viewing and adding to, 276

trusted publishers
designating, 7
macros by, 135

U
unbound controls, 411
unbound object frame controls, 415
underlining, keyboard shortcut for, 33
Unhide Columns dialog box (Access), 364
Unicode Compression field property, 366
union queries, 450
update queries, 445–446
updating data, 166–167
up-down bars, 214
Use A Style To Format Contents option, 148
Use The Insert Key To Control Overtype Mode option, 

6
user access, restricting, 15–17, 173–175
user accounts, appending permissions to, 574
user alerts in SharePoint, 555–556
user content. See content; items (SharePoint)
user names, defining, 4
user operations, restricting, 171
user profiles

configuring, 590–592
information in, 583
searches based on, 631

user templates, applying to databases, 344–346
users

adding to SharePoint security groups, 574
editing restrictions on, 14, 154–155
initials of, 74
permissions, setting, 16
Read or Change permissions, 173

V
Validation Rule field property, 365–366
validation rules

for database fields and records, 368
for database tables, 353, 355
 for mailing addresses, 119

Validation Text field property, 366
#VALUE error value, 193
values, rounding, 52
vendors, of mail labels, 125
VeriSign, 318
version control

for document sets, 543
in SharePoint, 530–531

versions, merging, 78–80
View Code command (Access), 418
View In Browser link, 656
views

of PivotCharts, 258–260
of reports, 492
of SharePoint repositories, 510–516

Visible property, 411
Visio diagrams

creating, 639–640
viewing and refreshing in browser, 634

Visio Services, 634
Visitors SharePoint security group, 572
Visual Basic, 129

macros, recording in, 140–141, 277–280
opening, 277, 280

W
Watch Window, 193–194
Web Analytics Web Part, 581
Web browser controls, 413
web browsers

databases, interacting with, 635
Visio diagrams, updating, 634

Web Database sites, 546
web databases. See also databases

caching options, 328
Client Forms command, 406
control layouts, 423
forms tools and options, 395, 396, 406–407
navigation forms, 405, 406
Report Center, 637
working with, 322–323

web drawings, updating, 634
web forms, 395
web pages configuration options, 6
Web Part pages, 546, 561

creating, 562
Web Parts

adding to site, 562–564
Chart Web Part, 662

Web Parts
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Web Parts (continued)
closing, 564
Colleague Tracker Web Part, 584–585, 587–588
configuring, 562
Current User Filter Web Part, 663
dashboards, adding to and configuring, 659–664
Excel Web Access Web Part, 663
exporting and importing, 566–567
hiding and removing, 564–565
Key Performance Indicator Web Part, 661
managing, 561–567
My Links Web Part, 600
My Site, adding to, 599–606
Organization Browser Web Part, 598–599
RSS Viewer Web Part, 588, 590
search visibility, setting, 613
Tag Cloud Web Part, 604–605
types of, 561
Web Analytics Web Part, 581

Web Parts Control Description files, 566
web queries, properties, 264
websites, connecting to Excel, 263–264, 268
what-if analyses, 225–236

with data tables, 227–230
with Goal Seek, 226–227

what-if scenarios, 230–233
wiki pages, 561
Win/Loss sparklines, 217
windows, protecting structure of, 171
Windows Explorer

preview pane, 616
SharePoint sites, searching from, 607, 614–616

Windows Live ID, signing up for, 15, 173
Windows 7

search capabilities, 614
XLStart folder, 275

Windows Vista, XLStart folder, 275
Windows XP, XLStart folder, 275
Word Options dialog box, 3–8

Add-Ins page, 6
Advanced page, 5–6
Confirm File Format Conversion On Open, 116
Customize page, 6
Customize Ribbon page, 6
Customize The Quick Access Toolbar page, 141–142
Display page, 4
General page, 4
information icon, 4
Language page, 5
Proofing page, 4, 8–11
Save page, 5
style pane area, 42
Trust Center page, 7
user name and initials, 77

Word 2003 XML Document format, 152
Word 2010. See also documents

advanced font and paragraph attributes, applying, 
33–46

charts, creating, 46–59
documents, reviewing, comparing, combining, 73–82
envelopes and labels, creating, 121–127
forms, creating, 143–153
forms, manipulating, 154–158
functions in, 51–52
indexes, creating, 95–101
macro operations, 130
macro options, applying and manipulating, 137–143
macros, recording, 130–133
mail merge operations, executing, 103–114
mail merge operations, other data sources for, 

114–121
options, configuring, 3–12
protection, applying to documents, 13–18
reference pages, creating, 82–91
reusable content, constructing, 59–68
saving documents to My Site from, 597
setting Personal Documents as a location, 596–597
tables, creating, 46–59
tables of authorities, creating, 91–95
templates, applying to documents, 18–31
text boxes and sections, linking, 68–71

WordArt objects, inserting, 36
workbook calculation, 195–197
Workbook Connections dialog box (Excel), 269
workbooks

access, setting up, 161
appending new data, 168
calculating, 197
compatibility with earlier versions of Excel, 164
default save format, 274
distributing to groups, 182, 183
existing data connections in, 268–269
formula options, 195–198
links, editing, 269–271
macros, running, 274
macros, running on open, 282–284
macros, saving in, 273
merging, 182–184
overwriting data in, 168
passwords, adding, 175–176
properties, setting, 164–166
protecting, 171–172
publishing on a server, 635
reviewing changes in, 181–182
sharing, 179–181, 183
sharing, preparing for, 161, 176–179
sharing in SharePoint, 263
structure, protecting, 161, 171, 172
template, saving as, 161, 162–164
tracking changes, 179–181
updating data in, 249
user access, restricting, 173–175
and Word, working with, 116
XML maps, adding to, 168
XML maps, associating, 167

workflow templates, 532

Web Parts
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workflows
approval workflows, creating, 533–534
components of, 532–533
creating, 533
deleting, 535
managing, 531–535
modifying, 533
start options, 533
types of, 532

Works Cited list, 86–87
worksheets. See also charts

ActiveX controls, adding, 300–303
calculating, 197
cell relationships in, 185–187
connecting to Access databases, 262–263
data summary options, 199–206
data tables, adding, 227–228
error values, 192–193
exporting data to Access, 384–385
external references in, 269–270
formatting, 50
form controls, adding, 291
hidden, 176
inputs, tracing, 185–187
inserting in Word documents, 48
linking Access databases to, 392–393
protecting, 171–172, 298
ranges, defining, 172
recalculating, 196–197
sparklines, adding, 218

workspaces, 648–655
from Calendar lists, 577
creating, 576–580, 649–650
document workspaces, 578–579
File tab commands, 650
meeting workspaces, 579–582
offline access, 654–655
online access, 655
synchronizing, 651, 655

write access, password for, 162
Write & Insert Fields group, 104, 107, 110
writing style, checking, 10

X
.xlsm file name extension, 273
XLStart folder, 275
.xlsx file name extension, 50, 273
.xltm file name extension, 273
XML data

importing and exporting from Excel, 166–169
map properties, 169
validating, 168

XML elements, mapping to worksheet cells, 166–167
XML files

as Excel data source, 265, 266
importing into Access, 389

XML Map Properties dialog box (Excel), 168
Append New Data To Existing XML Tables, 168
Overwrite Existing Data With New Data, 168
Validate Data Against Schema For Import And Export, 

168
XML maps, 167

adding to workbooks, 168
sharing workbooks and, 180

XML Options dialog box (Word), 152
XML schemas, 151

adding to workbooks, 166–167
alias for, 151
root element, adding to document, 151

XML Source pane (Excel), 167
XML Structure task pane (Word), 151
XPS files, publishing database objects as, 320–321

Y
Yes/No data type, 349

Z
Zoom dialog box (Access), 462–463

Zoom dialog box (Access)
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